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Capitolo 1

Introduzione

Questo manuale illustra le caratteristiche di personalizzazione presenti in LyX.
Verranno di seguito discussi temi come le scorciatoie da tastiera, le opzioni di an-
teprima sullo schermo, le opzioni di stampa, i comandi da inviare a LyX attraver-
so il IyX Server, 'internazionalizzazione, ’installazione di nuove classi di testo
ETEX e layouts di LyX ecc. Ovviamente non ci possiamo augurare di prendere
in considerazione tutto quello che & possibile cambiare—i nostri sviluppatori ag-
giungono nuovi funzioni pit velocemente di quanto riusciamo a documentare—ma
andremo a spiegare le personalizzazioni piu comuni e possibilmente cercheremo
di darvi qualche indicazione per quelle pitt complesse.

LyX 1.1.6 introduce una nuova interfaccia utente per le personalizzazioni
che possono essere richiamate attraverso Edit> Preferences. Questo non rende
obsoleta la seguente trattazione circa i files di configurazioni di Iy’X, ma si
spera invece che semplifichi considerabilmente I’adattamento di LyX alle vostre
necessita.
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Capitolo 2

File di configurazione di IyX

Questo capitolo ha lo scopo di aiutare ad orientarsi all’interno dei file di configu-
razione di LyX. Prima di continuare a leggere questo capitolo, dovreste trovare
dove si trova la directory delle librerie di IiyX usando Help>Version. Questa
direcotry ¢ il posto in cui LyX mette i suoi files di configurazione generale, che
chiameremo LyXDir nel prosieguo del documento.

2.1 Cosa c’é in LyXDir?

LyXDir e le sue sottodirectory contiene numerosi files che possono essere usati
per la personalizzazione del comportamento di LyX. Nuovo in IyX 1.1.6 € la
possibilta di richiamare questi files dall’interno dello stesso Ly X attraverso il
menu Edit > Preferences. La maggior parte delle personalizzazioni che si ef-
fettuano sono possibili attraverso questo menu. Tuttavia, molti altri aspetti
principali di LyX possono essere personalizzati modificando gli altri file nella di-
rectory LyXDir. Questi sono divisi in differenti categorie, descritte nelle seguenti
sottosezioni.

2.1.1 Files generati automaticamente

Questi files vengono generati quando configurate LyX. Contengono vari valori
predefiniti che vengono fissati mediante una procedura di ispezione. In generale,
non & una buona idea modificarli, dato che potrebbero essere sovrascritti in
qualsiasi momento.

lyxrc.defaults contiene i valori di default per vari comandi. Se non gradite
alcuni dei valori assegnati, potete reimpostarli usando la nuova voce
Edit > Preferences.

packages.lst contiene la lista dei pacchetti che sono stati riconosciuti da
LyX. Non é normalmente usata dal programma, ma le informa-
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10 CAPITOLO 2. FILE DI CONFIGURAZIONE DI LyX

zioni estratte, ed anche di piu sono rese disponibili attraverso Help
>LaTgX Configuration.

textclass.lst ¢ la lista delle classi di testo che sono stati trovate nella vostra
directory layout/ , insieme alla classe di documento LateX associata
e relativa descrizione.

doc/LaTeXConfig.lyx é generata automaticamente durante la configurazione
dal file LaTeXConfig.lyx.in. Ogni stringa del form “@chk foo@”

verra sostituito con “si” o “no” a seconda di dove sia stato trovato il
pacchetto foo .

2.1.2 Directories

bind/ questa directory contiene i files con I’estensione .bind che definisco-
no i tasti di scelta rapida usati in LyX (vedere la sezione ?7). Se esi-
ste una versione internazionalizzata del bindfile chiamato $LANG_xxx
, questo sard usato per primo. Vedere il capitolo 5, e la sezione??
per i dettagli.

clipart/ contiene immagini Postscript@®) che possono essere inclusi nei docu-
menti.

doc/ contiene i files di documentazioni di IyX (incluso quello che state
ora leggendo). Il file LaTeXConfig.1lyx ¢ particolarmente speciale,
come gia detto. Se esiste una versione internazionale del documento
di aiuto con $LANG_ preposto al nome, quello sara usato per primo.
Guardare il capitolo 5 per i dettagli.

examples/ contiene files di esempio che spiegano come usare alcune caratteristi-
che. Nel file browser premere il pulsante Example per raggiungerlo.

images/  contiene files di immagine che sono usati nel menu Document. In ag-
giunta, vi sono contenute anche le icone idividuali usate nella toolbar
e nella schermata che viene mostrata all’avvio di LyX.

kdb/ contiene i files di keymapping della tastiera. Guardare il capitolo 5.5
per i dettagli.

layouts/ contiene i files di classi di testo descritti nel capitolo 6

scripts/ contiene alcuni files che dimostrano le capacita dell’insieme Exter-
nal Template. Riferirsi a Help > External > Material per ulteriori infor-
mazioni. [Nota dell’autore: se questo file & incorporato in un altro

dei documenti standard, mon sara reperibile in questa locazione—
AL

templates/ contiene ifiles templates standard di Ly X descritti nel Capitolo 6.4.

tex/ contiene alcuni files .cls distribuiti con LyX.

.bind
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ui/ contiene i files con estensione .ui che definiscono l'interfaccia utente
di IyX. Cioé i files definiscono quali oggetti appaiono in quali menu
e quelli che appaiono nella toolbar. Riferirsi al Capitolo 3.4per i
dettagli.

2.1.3 Files che non volete modificare

Questi files sono usati internamente da IyX e generalmente non avete bisogno
di modificarli a meno che non siate sviluppatori.

CREDITS  questo file contiene la lista degli sviluppatori di LyX. Si puo accedere
a questo file attraverso il menu Help > Credits.

chkconfig.ltx questo & uno script BTEX usato durante il processo di configu-
razione. Non va lanciato direttamente.

configure questo ¢ lo script usato per riconfigurare LyX. Crea files di configu-
razione nella directory in cui & lanciato.

2.1.4 Altri files che necessitano di una riga o due di spie-
gazioni...

encodings 777

external_templates questo file contiene i template disponibili nella nuova
funzione External Template. Riferirsi a Help > External Material per
ulteriori informazioni.

language questo file contiene una lista di tutti i linguaggi correntemente sup-
portati da LyX.

2.2 La vostra directory di configurazione

Anche se si usa LyX come utente non privilegiato, é possibile voler cambiare
la configurazione per un uso personale. La directory UserDir contiene tutti i
files della vostra configurazione personale. E’ questa la directory descritta come
come “user directory” in Help > Version. Questa directory ¢ usata come mirror di
LyXDir, il che significa che ogni file in UserDir é un sostituto del corrispondente
file in LyXDir. Ogni file di configurazione descritto nelle sezioni precedenti puo
essere posizionato sia nelle grandi directory di sistema, in quel caso agira su tutti
gli utenti, sia nella vostra directory locale per un uso di carattere personale.
Per rendere chiare le cose, si forniscono alcuni esempi:

e Per personalizzare il comportamento di IyX prima della versione 1.1.6,
I'utente doveva copiare il file LyXDir/lyxrc.example in UserDir/lyxrc
e modificarlo direttamente. La nuova versione di IyX legge ancora questo
file, se presente in UserDir, ma ogni cambiamento successivo fatto usando
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il nuovo menu Edit > Preferences sono salvate nel nuovo file preferences.
In seguito lyxrc non sard piu letto e potra essere rimosso.

¢ Quando si riconfigura attraverso Options > Reconfigure LyX lancia configu-
re ed i files risultanti sono scritti nella vostra directory di configurazione
locale (vedere la sezione 3.10per avere una lista dei settaggi di> questa
sezione).Questo significa che ogni classe di testo addizionale che potreste
aver aggiunto alla directory UserDir/layouts sara aggiunta alla lista delle
classi nel menu Layout> Document.

e Similmente, se avete installato alcune classi di documento IKTEX nella
vostra home directory, che INTEX puo trovare nel vostro path TEXTINPUTS,
queste verranno mostrate nella lista delle vostre classi di testo.!

o Se acquisite della documentazione aggiornata dal sito ftp di LyX e non
potete installarla perché non avete i permessi di amministratore sul vostro
sistema, potete semplicemente copiare i files in UserDir/doc/ e saranno
raggiungibili attraverso il menu Help!

2.3 Lanciare IyX con configurazioni multiple

La liberta di configurazione della relativa directory locale pud non essere suf-
ficiente se volete avere pitt di una configurazione a vostra disposizione. Ad
esempio, vorreste poter usare differenti scorciatoie da tastiera o settaggi della
stampante in tempi diversi. Potete ottenere questo attraverso piil directory che
verranno richiamate al run-time.

Richiamando LyX con lo switch da riga di comando -userdir <some direc-
tory> permette al programma di leggere la configurazione da quella directory e
non dalla directory di default (potete scegliere la directory di default lanciando
IyX senza lo switch descritto sopra). Se questa directory non esiste, LyX pud
crearla per voi proprio come fa per la directory di default la prima volta che
si lancia il programma. Potete modificare le opzioni di configurazione in que-
sta Userdir addizionale esattamente come fareste per la directory di default.
Queste directory sono completamente indipendenti (ma continuate a leggere).
Notare che settare la variabile ambientale LYX_USERDIR_11x allo stesso valore
ha esattamente lo stesso effetto.

Avere molte configurazioni richiede anche piti manutenzione: se volete ag-
giungere un nuovo layout a Userdir/layouts che volete disponibile per tutte
le vostre configurazioni, dovete aggiungerlo ad ogni directory separatamente.
Potete evitare questo col seguente trucco: dopo che LyX ha creato la directory
addizionale, la maggior parte delle sottodirectory (vedi sotto) sono vuote. Se
volete che la nuova configurazione faccia da mirror ad una esistente, sostituite
la sottodirectory vuota con un link simbolico alla relativa sottodirectory di una
configurazione esistente. Fate attenzione tuttavia alla sottodirectory doc/ dato

Lcome pure se voi o IyX abbiate un file .layout per esso, naturalmente.
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che contiene un file generato dallo script di configurazione (accessibile anche
attraverso Options> Reconfigure 3.10) che ¢ specifico per ogni configurazione.
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Capitolo 3

Il popup Edit > Preferences

3.1 Usare il popup per la prima volta

Storicamente, € possibile personalizzare il comportamento di LyX attraverso
la modifica del contenuto del file UserDir/lyxrc. Questo é cambiato in LyX
1.1.6 perché ora esiste un menu Edit>Preferences per semplificare il processo
di semplificazione. UserDir/lyxrc verrd ancora letto fino a quando non si usa
il nuovo menu per la prima volta. Successivamente, ogni cambiamento sara
salvato in un nuovo file, preferences, e lyxrc non sard piu letto. Potra cosi
essere rimosso.

Il nuovo file UserDir/preferences conterrd solo i cambiamenti che sono
stati fatti nel comportamento di base, alcuni dei quali sono ben codificati in LyX
ed altri sono contenuti nel file di sistema LyXDir/lyxrc.defaults. Notate che
in entrambi i files le righe che iniziano con “#” sono solo commenti e non sono
interpretati. Tuttavia, solo gli amministratori di sistema dovrebbero editare
LyXDir/lyxrc. Gli utenti dovrebbero usare la voce Edit > Preferences per creare
e modificare il loro file personale UserDir/preferences.

Speriamo che il menu Edit > Preferences sia ampiamente autoesplicativo. A
quasi tutti i comandi sono stati associati dei commenti, cosi da non crearvi parti-
colari difficolta ad effettuare modifiche a vostro piacimento. Prima di analizzare
alcuni dei comandi pitl importanti di seguito, vogliamo fare un avvertimento:
L’applicazione di alcuni dei cambiamenti (es. fonts dello schermo) hanno effetto
istantaneo. Altri (es. cambiamenti nel file associazioni) non l’avranno. Ab-
biate pazienza; questo & un work-in-progress. Se nulla sembra accadere come
cambiamento salvate i cambiamenti e riavviate LyX.

3.2 Schermo & Fonts

Il carattere usato per visualizzare i vostri documenti sullo schermo di LyX &
molto importante, dato che leggerete tutti i documenti con questo carattere.
Inoltre & importante che il carattere sia leggibile ed abbia il miglior aspetto

15



16 CAPITOLO 3. IL POPUP EDIT> PREFERENCES

possibile. Il IyX team ha provato a fornire il migliore carattere predefinito, ma
dato che praticamente tutti i sistemi X11 sono differenti, & molto probabile che
il carattere predefinito sia sub-ottimale per il vostro sistema. Fortunatamente
é possibile ovviare a tale situazione, ma prima di chiarirvi le modalitd secondo
le quali procedere, sarebbe bene che sapeste qualcosa di pii sui font in quanto
la loro scelta nasce da un compromesso tra le vostre preferenze e le capacita del
sistema col quale lavorate.

Notate che questa sezione tratta solo dei caratteri visibili sullo schermo al-
Iinterno della finestra di LyX. I caratteri che appaioni sulla carte in uscita dalla
stampante sono indipendenti da questi e sono determinati dalla classe del do-
cumento. Consultate la Guida dell’utente per imparare a cambiare il carattere
della versione stampata del vostro documento.

Di base, i caratteri che appaiono sullo schermo sono di due tipi differenti:
caratteri scalabili e caratteri bitmap non scalabili. La distinzione pud sembrare
leggermente arbitraria, dato che i font non-scalabili sono generalmente scalabili
nella maggior parte dei moderni renderers di font. La differenza sta nella qualita
dello scaling, e nella velocitd con cui essi vengono visualizzati. Da cid ne deriva
I'importanza di capire dove sia bene usare 'uno o l’altro tipo di font.

I caratteri scalabili sono costruiti a partire dai contorni di ciascun glifo (cioé
carattere) presente nel font. Questo significa che ogni glifo ¢ definito attraverso
curve matematiche che bene si adattano allo scaling di qualsiasi dimensione. Il
renderer di font ha quindi il compito di interpretare tale definizione e generare
una piccola figura composta di pixels in relazione alla grandezza ed al glifo
richiesto dal programmatore. Ne segue che 'aspetto dei font scalabili risulta
buono per ogni dimensione, piu realisticamente per quasi tutte le dimensioni.
Infatti i fonts scalabili sono definiti in modo astratto e di conseguenza puo essere
difficile ottenere un buon rendering per taglie piccole, dove ogni pixel deve essere
perfettamente calcolato per ottenere una buona immagine. Tale operazione é
tecnicamente attuabile mediante la definizione matematica, ma per consentire
un rendering ragionevolmente veloce, si preferisce raggiungere un compromesso,
con il risultato é che i font scalabili sono piu difficili da leggere per le piccole
dimensioni.

I font bitmap invece sono definiti da grafica bitmap sin dall’inizio, cosi appa-
iono buoni per ogni dimensione richiesta. tuttavia, non scalano bene, perché per
scalare un glifo, ogni pixel ¢ allargato in piu pixel. E’ quanto accade se cercate di
allargare una fotografia in zv o in qualsiasi altro programma di manipolazione.
Per ridurre questo effetto, i font bitmap sono forniti in varie dimensioni presta-
bilite, in genere da 8 pixel a 34 pixel o piil in relazione ai possibili utilizzi. Il
vantaggio derivante dall’uso di font bitmap & che per visualizzare ogni glifo non
sono necessari calcoli complessi, cosi da rendere i font bitmap pit velocemente
rappresentabili sullo schermo rispetto ai font scalari. Lo svantaggio consiste
nel fatto che le dimensioni non comprese in quelle predefinite, devono essere
ottenute raddoppiando i pixel, e conseguentemente 1’aspetto non é dei migliori.

Se ne conclude quindi che i font bitmap sono generalmente i migliori per
le piccole taglie, dove disponibili, mentre i font scalabili sono da preferire per
grandi dimensioni. La logica conclusione sarebbe quella di usare i font bitmap
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per le piccole dimensioni, ed i font scalabili per le dimensioni superiori. Sfortu-
natamente questa non ¢ una buona idea, dato che i font bitmap e i font scalabili
non sono stati progettati per essere usati insieme ed il risultato derivante dal
loro contemporaneo utilizzo sarebbe piuttosto sgradevole. La soluzione ottimale
é dunque quella di provare entrambi gli schemi e scegliere tra i due quello che
meglio si adatta alle proprie esigenze.

Di default, Lyx usa i font bitmap non-scalabili. Per i font serif, & usato
times, per i font sans serif, & usato helvetica, mentre curier é usato come font
monospazio stile macchina da scrivere.

In seguito descriveremo cosa fare se in LyX il testo non ha un bell’aspetto.
Partiremo con i parametri pit importanti: DPI e lo zoom dei fonts.

3.2.1 Settaggi DPI e Zoom di Font

LyX automaticamente prova a scalare i fonts in modo da farli sembrare il pit
possibile uguali a quelli che verranno stampati, a meno del cosiddetto fattore di
70O

Per far funzionare su ogni sistema, questo meccanismo sfrutta i settaggi
dei DPI (dots per inch) dello schermo. 1l settaggio dei DPI del vostro sistema ¢
rilevato automaticamente da LyX attraverso le informazioni che fornisce il server
X. Potete controllare cosa rileva Iy X circa i DPI, lanciando LyX in questo modo:
lyx -dbg 2.

Su molti sistemi, X non & settato correttamente, quindi dovrete verificare la
correttezza dei settaggi manualmente. Lanciate “xdpyinfo | more” e scrivete
quali sono i DPI per la risoluzione che usate (che dovrebbe essere simile a quella
che LyX rileva). E’ il numero menzionato come “risoluzione”. Inserite poi anche
il numero di pixel che avete in larghezza ( il primo numero sotto “dimensioni”).

Dopodiché prendete il buon vecchio righello e misurate la larghezza visibile
dell'immagine su vostro monitor. Convertite queste misure in pollici, se usate
un righello in centimetri, dividendo per 2.54. Ora é possibile determinare il
corretto settaggio DPI per il vostro schermo, dividendo il numero dei pixels della
larghezza per la larghezza dell'immagine sullo schermo del monitor. Se questo
numero € superiore a, per esempio, 5 DPI rispetto al valore autodeterminato,
dovrete correggere I’ X setup, o almeno dire a IyX che il valore di DPI e diverso
da quello rilevato.

Se non potete correggere I’X setup (che sarebbe la soluzione migliore perché
ne beneficerebbero altri programmi oltre a IyX), é possibile comunicare a IyX
il corretto settaggio DPI attraverso il menu Preferences.

Se il testo e troppo piccolo o troppo grande per il vostro gusto, dovrete
cercare di rimendiare attraverso lo zoom sul carattere. Questo settaggio & usato
per scalare la grandezza del punto del testo. Se il vostro DPI é corretto, e lo
zoom del carattere e settato a 100, questo significa che LyX provera a mostrare
il testo esattamente alla stessa grandezza della pagina stampata. Se il fattore
di zoom viene settato a 200, il testo visualizzato sara il doppio di quello che si
vedra sulla pagina stampata. Naturalmente questo accadra solo se Ly X riesce a
trovare ed usare un carattere che abbia una grandezza appropriata. Ma, dato
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che LyX & comunque un sistema WYSIWYM, questa limitazione, eventuale, &
improbabile.

Il valore di default dello zoom ¢ 150 dato che un monitor ¢ generalmente
pit grande che un pezzo di carta, ma dovreste comunque provare a modificarlo
tramite il comando Font Zo.default nel menu Preferences per trovare una gran-
dezza che vi soddisfi. Quando avete trovato un settaggio che possa andare bene
per voi (tip: usate il bottone Apply per lasciare la finestra aperta mentre fate
esperimenti), potete poi rendere questi settaggi come default usando il comando
Save.

Mentre é spesso possibile trovare una grandezza adatta al testo sullo schermo,
questo non necessariamente vuol dire, che i fonts siano i migliori ottenibili dal
proprio sistema. Per aiutarvi ad avere il massimo dal vostro sistema, potete
usare 1 comendi di definizione dei font per raffinare ’aspetto del testo piu in
dettaglio.

3.2.2 Comandi di definizione dei Fonts

Come menzionato, LyX usa fonts bitmap non scalabili di default. Per i fonts
serif, & usato times, per i fonts sans serif & usato helvetica, mentre courier é
usato come font del tipo monospazio/macchina da scrivere.

Potete cambiarli attraverso il menu Preferences. Il numero dei fonts dispo-
nibili varia a seconda dei sistemi, ma il programma xfontsel dovrebbe essere
reperibile ovunque. Usate questo programma per trovare i fonts adatti. Quando
avete trovato un font che vi piace, provate ad inserire i primi due elementi del
nome (chiamati “fndry” e “fmly” in xfontsel) nel campo appropriato nel menu
Preferences e premere Apply. IyX poi riformattera il vostro documento usando
il nuovo font, e se il font vi piace, dovreste salvarlo con Save. Un punto di
partenza per un nuovo font é vedere se il font scalabile “utopia” é disponibile.
Tip: potete vedere se un font € scalabile o bitmap controllando i campi “resx” o
“resy” in xfontsel. Se il valore 0 & disponibile, il font & scalabile. Se il valore 0
non & disponibile, il font é bitmap.

Prima che proviate a modificare un font bitmap perché la larghezza pia
grande sembra “bloccata”; dovreste provare a selezionare il bottone “Usa fonts
scalabili”. Questo ¢ utile solo se usate fonts bitmap, perché solo questi non sca-
lano perfettamente. Se definite questo flag, LyX usera solo le grandezze fisse del
carattere disponibili, e questo garantisce che tutti i fonts bitmap sembrino buo-
ni. (Potete vedere quale grandezze individuali del carattere son o disponibili con
il comando x1sfonts. Provate man x1lsfonts). Tuttavia il prezzo da pagare &
che la differenza tra la grandezza del font sullo schermo e la grandezza del font
sulla carta sara piu grande perché LyX dovra accontentarsi della grandezza piu
vicina disponibile, e non provera a scalare la grandezza per adeguarsi. Inoltre,
c’é il ridchio che alcune grandezze differenti da un punto di vista logico, come
Large e Larger, saranno mappate come lo stesso font sullo schermo, rendendo
difficile identificare le differenze sullo schermo. Abbiamo deciso di non usare i
fonts scalabili di default a causa di questi effetti, ma dato che Iy’X é un sistema
WYSIWYM, a molte persone piace comunque usare i flag, pur sapendo che la
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grandezza del carattere sullo schermo potrebbe non essere veritiera. Ma ricorda-
te che questo flag crea una differenza solo se usate font bitmap. I font scalabili,
come ora potete capire, non verranno toccati da questo tipo di problema.

Un’ultima annotazione su questo flag: dovete sapere che non c’é nulla di
sbagliato nell’usare fonts scalabili e bitmap contemporaneamente per differen-
ti scopi. Per esempio, é abbastanza comune usare lo scalabile “Utopia” per il
testo serif, assieme alla versione bitmap di “Helvetica”. E potete tranquillamen-
te selezionare “Usa fonts scalabili” senza problemi: sarad solo applicato al font
Helvetica.

Qualche volta gli artefatti introdotti dall’uso del flag possono essere elimi-
nate usando il comando fine-detail che definisce a quali grandezze di punto
corrispondono le differenti grandezze logiche dei caratteri. Lanciate LyX con
lyx -dbg 513 per vedere come funziona concretamente e provate ad aggiustare
le voci corrispondenti nel menu Preferences fino a quando i risultati vi soddisfa-
no. Questo é difficile da fare, perché LyX usa i settaggi DPI e quelli di zoom
del font per calcolare 'esatta grandezza del font sullo schermo da chiedere al
server X. Se non riuscite ad ottenere risultati soddisfacenti con la tecnica dello
“sbaglia e riprova”, potete rendere il processo piu trasparente se settate assieme
i DPI e lo zoom a 100, anche se si sa che non é corretto. questo naturalmente
renderd i font scalabili non perfetti, quindi fate attenzione.

3.2.3 Codifica dei Fonts

Di default, LyX usera dei font per scrivere un testo Western European, inclu-
si tutti i tipi di inglese. Viene definito attraverso il cosiddetto font encoding.
Se volete usare Lyx per scivere ad esempio un testo in Eastern European, Ci-
rillico oppure ogni altro linguaggio non coperto dallo standard ISO-8859-1 di
codifica dei caratteri, potete definirne uno differente con il settaggio del valo-
re \screen_font_encoding .Questo richiede che siano installati speciali fonts.
Potete usare xfontsel per queste modifiche: controllate i campi “rgstry” e
“encdng” per valori ISO-8859-X diversi da ISO-8859-1, e quindi cercate quel-
lo che contiene i caratteri della lingua prescelta. Se non lo trovate & ancora
possibile definirlo nel file 1yxrc .Altrimenti bisogna ricercarlo sul Web.

Quando settate LyX per 'uso di una codifica differente, dovrete considerare
i cambiamenti nei fonts della finestra pop-up di LyX. Per esempio il menu Ta-
ble of Contents non sara comprensibile fino a quando non dite a LyX di usare un
font differente. Di default, il menu font é settato su -*-helvetica-medium-r,
ma spesso helvetica non é disponibile nella codifica dei font di cui avete bisogno.

Inoltre potete cambiare questo font con il comando \screen_font_emenu .

Come potete vedere, ci sono alcune opzioni che possono essere usate per
affinare I'aspetto dei vostri fonts. Questo non dovrebbe spaventarvi dal maneg-
giare coi settaggi, poiche dopo tutto, vi augurate di usare molto LyX in futuro.
E contrariamente ai veri word processors WYSIWYG, dove siete costretti ad
usare fonts che hanno un aspetto buono sia sul video che sulla carta, LyX vi da
la possibilita di usare fonts che sono disegnati per essere visti sullo schermo, se
siete abbastanza fortunati da averli.
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Nella versione di LyX, proveremo a supportare il font renderer T1Lib che
fornisce un testo con effetto anti-aliased . Questo significa che ogni glifo é
costituito da molte ombre colorate piuttosto che da soli due colori, creando un
effetto di alta risoluzione. Questo non rendera solo il testo piu leggibile sullo
schermo, ma permetterd anche a IyX di avvicinare i fonts visti sullo scermo
a quelli che verranno stampati, dato che sard ad esempio possibile settare un
valore di 14.4 punti al contrario di ora che é possibile solo scegliere il valore
arrotondato 14.

3.3 Bindings

Le associazioni sono usate per assegnare una funzione ad un tasto. Molti file
con associazioni precompilate sono disponibili: un set di associazioni CUA (si-
mile ai tipici insiemi di assegnazioni di tastiera PC e CDE), un set Emacs di
associazioni, per quelli di noi che segono la cosiddetta “One True Way” e rifiu-
tano di sottostare agli standards,! come pure associazioni speciali (broadway e
hollywood) ed altri linguaggi (Francese, Tedesco, ecc..)

Se, tuttavia, volete personalizzare le associazioni secondo i vostri specifici
gusti, allora copiate il file della directory LyXDir/bind/ che meglio si adatta
nella vostra UserDir/bind/ e modificatelo. Non dimenticate di caricare questo
nuovo file in IyX attraverso il menu Preferences (per il momento dovete riavviare
LyX per rendere effettivi i cambiamenti).

IyX supporta l'internazionalizzazione dell’interfaccia utente (vedere il Ca-
pitolo 5). Se il vostro locale viene settato con la variabile d’ambiente $LANG,
LyX provera ad usare i bindfile preponendo $LANG_ al loro nome. Ad esem-
pio, potete mettere una copia tradotta di alcuni bindfile nella vostra directory
bind/personale e LyX li userd automaticamente. [Nota dell’autore: non sono
sicuro se é ancora vero ma forse qualcuno che utilizza questo metodo potrebbe
testarlo—AL].

La sintassi dei files .bind é la seguente:

\bind <key combination> <lyx-function>

Sia le combinazioni di tasti che la lyx-function (inclusi gli argomenti) devono
essere racchiusi tra le “doppie virgolette”. Tutte le funzioni di LyX sono elencate
nella Guida di Riferimento.

3.4 User Interface

L’aspetto del menu e della toolbar pud essere cambiato attraverso il menu Prefe-
rences. Basta semplicemente cambiare il file .ui in LyXDir/ui/. Per il momento
esiste solo un file, default.ui, ma sentitevi liberi di sperimentare. Copiate il fi-
le che create nella directory UserDir/ui/ e andate! Notate che, per il momento,
dovete riavviare IyX per rendere effettivi i cambiamenti.

1Sto scherzando, ovviamente!
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La sintassi dei files .ui é la seguente: date uno sguardo a default.ui. Le
righe riferite alla barra dei menu, menu e toolbar devono terminare con un
esplicito end. Possono poi contenere dei sottomenu, oggetti, separatori, icone
e nel caso del menu “file”; una riga lastfiles. Un piccolo avvertimento. I
sottomenu possono essere inseriti in un menubar o menu, ma sono sempre definiti
come menus non come submenu.

3.5 Convertitori, Formati e Visualizzatori

LyX ha un nuovo e potente meccanismo per convertire da e verso ogni formato
di file utilizzando programmi esterni. Prendiamo un paio di formati, ad es.
LaTeX e PDF. Ora definiamo un convertitore da un formato all’altro. Nel nostro
esempio ci sono due possibili meccanismi.

1. Una conversione diretta, da ITEX a PDF usando pdflatex

2. Una via piu contorta attraverso formati e convertitori intermedi: BTEX a
DVI (usando latex) a PostScript@®) (usando dvips) a PDF (usando ps2pdf)

LyX sceglierd sempre la via piu veloce, cosi dovrete specificare due differenti
nomi di Format per i files .pdf per poterli usare entrambi. Entrambi sono
inclusi di default nel menu Preferences. Date un’occhiata e poi createne dei
vostri!

Inoltre, ogni Format puod essere visto con un Viewer associato ad esso. Ad
esempio, potreste voler usare ghostview per esaminare i files PostScript®).

[Nota dell’autore: Questa sezione probabilmente ha bisogno di essere espansa,
ma sostituisce completamente la prossima. In pit, non sono sicuro di quanto
importanti siano ancora le sezioni Stampante e Cambiare Colori. La sezio-
ne Ascii-Export ¢ ancora importante, sebbene ha bisogno di essere usata per
differenziare l’approccio lyzre da quello del menu Preference. — ALJ.

3.6 Anteprima sullo schermo

Oltre alla normale visualizzazione dei documenti attraverso LyX, € possibile
avere un’anteprima del vostro documento nella forma in cui apparira sulla carta
dopo stampato. Di default IyX usa xdvi per 'anteprima dei files .dvi (I'output
di BTEX).

Ly X pud anche usare dvips per convertire i files .dvi in .ps e ghostview per
I’anteprima. Si possono usare numerose opzioni nel filelyxrc per personalizzare
queste caratteristiche.

\view_dvi_command Permette di rimpiazzare xdvi con altri.dvi previewer, o
per passare argomenti a xdvi.

\view_ps_command Permette di rimpiazzare ghostview con il vostro PostScript
previewer preferito, oppure per passare argomenti a ghostview.
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\view_pspic_command Definisce il programma usato per ottenere anteprime a
tutto schermo delle figure PostScript@®). Non ¢ possibile includere alcuna
opzione in questo tipo di settaggio.

\ps_command Definisce il programma per usare le figure PostScript all’interno
di un documento LyX. Non é possibile includere nessuna opzione. Se
viene definita una stringa vuota (""), LyX non processera nessuna figura.
Questo puo essere utile se avete una macchina lenta e lavorate con molte
figure.

\default_papersize Setta la grandezza della carta usata da LyX per fare ’an-
teprima dei documenti. Il valore di default é la carta USletter. Se I’ TEX &
configurato per usare una differente grandezza di default, potrete cambiare
questo settaggio.

3.7 Opzioni ASCII-Export

Ci sono alcuni comandi che possono essere usati per “ripulire” i files di testo
esportati in ASCIIL. Notate che LyX automaticamente riconosce ed usa il miglior
settaggio per il vostro sistema sin dalla fase di installazione, ma & possibile
modificarli se non vi piacciono.

\plaintext_roff_command Questo comando vi permette di settare il comando
per produrre migliori tabelle ASCII con i comandi UNIX groff/troff/nroff
(veferirsi alle relative man pages per ulteriori informazioni). Non
definirlo per niente dice a IyX di usare il formattatore interno (in-
feriore).

\plaintext_linelen Con questo comando potete settare la lunghezza di de-
fault della riga dell’output di un file ASCII. Settarlo a 0 significa
righe infinite. Il Default & 75 caratteri.

Examples:

# This let’s you generate ASCII tables with latinil
# characters, using the groff formatter

#

\plaintext_roff_command groff -t -ms -Tlatini"

# This let’s you generate ASCII tables using the
# nroff formatter

#\plaintext_roff_command "nroff"

# This sets the line length to 80 characters

#

\plaintext_linelen 80
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3.8 Stampante

Ci sono una serie di comandi che vi aiutano a settare il comando della stampante
da LyX. Normalmente si usano solo alcuni di questi, ma vengono riportati tutti
per questione di completezza.

\printer Questo valore definisce il nome di default della vostra stampante.

\print_command Questo valore definisce quale comando LyX deve essere usato
per stampare il vostro documento.

\print_evenpage_flag Questo valore definisce quale flag del comando di stam-
pa comportera la stampa delle sole pagine pari.

\print_oddpage_flag Questo valore definisce quale flag del comando di stam-
pa si occupera di stampare solo le pagine dispari.

\print_reverse_flag Con questo comando, potete definire quale comando di
stampa si occupera di stampare le pagine in ordine inverso.

\print_landscape_flag Questo comando definisce quale flag é settata quando
si richiede di stampare il proprio documento in landscape. se il documento
é stampato in portrait, nessuna opzione é passata.

\print_to_printer Se specificate un esplicito nome per la stampante, dovrete
preporre questo nome con un flag dalla linea di comando della stampante.
Questo comando definisce quale flag dovrebbe apparire prima del nome
della stampante.

\print_to_file Se volete stampare su un file, dovrete utilizzare un flag prima
del nome del file. Questo comando vi permette di definire come apparira
questo flag.

\print_file_extension Quando stampate su un file, con questo comando
potete definire quale estensione potra avere il file stampato.

\print_extra_options Con questo comando potete definire una serie di flags
che saranno inseriti nel comandi di stampa dopo gli altri flags.

\print_spool_cmd Se si specifica qualcosa in questo comando, IyX stampera
in due fasi: Prima sard eseguito il programma specificato nel comando
\print_command con le direttive per stampare su un file. Poi, il coman-
do specificato con \print_spool_cmd sard eseguito col file di uotput col
precedente comando sulla riga di comando, e, se specificato, la direttiva
(\print_to_printer) per mandare l'output ad una stampante definita
prima del nome del file.

Tutto sommato, speriamo che questo vi permetta di stampare i vostri documenti
senza, problemi.
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3.8.1 Changing Colors

E’ possibile cambiare i colori dello schermo usando il nuovo menu Preferences.
Alternativamente, se vi sentite particolarmente perversi potete usare la funzione
associabile set-color (vedere la Guida di Riferimento). L’input avra il seguente
formato:

set-color LyXName X11Color

Di seguito ¢ presentata una lista (parziale) delle funzioni e dei colori di
default:

| Nome IyX | Scopo | Colore di default (X11) |
background text background black
foreground text foreground linen
latex ETEX code DarkRed
math Mathed formulae DarkBlue
mathline fraction Lines, brackets, etc. Blue
mathbag AntiqueWhite
mathframe black
selection selection background LightBlue

La lista completa si trova correntemente solo nel file sorgente LColor.cpp

3.9 TEX

Alcuni siti? hanno ancora la versione 2.09 di ITEX. Sebbene non possiamo
immaginare perché questo dovrebbe essere ancora il default dato che la versione
2.09, essendo questa obsoleta dal 1994, dovremo comunque continuare a riferirci
con LyX a tale ambiente. Non bisogna pensare perd ad un “fixing” di LyX
per girare sotto ITEX 2.09. Aggiornare il vostro IATEX sard piu facile, ed ¢
comunque la soluzione migliore. Molti grandi sistemi dovrebbero avere, anche se
di default hanno la 2.09, una versione disponibile di IXTEX2, ma forse ’eseguibile
potrebbe avere un altro nome. Potete cambiare il nome del comando ATEX
appropriato, come ad esempio "1yxrc “3con la linea:

\latex_command latex2e

nel vostro file 1yxrc. Al momento dell’installazione, LyX provera a rilevare
automaticamente se questo settaggio & necessario, quindi normalmente, non ve
ne dovrete preoccupare.

2
3

come la mia macchina da ufficio — Dave johnson
come la mia macchina da ufficio — Dave johnson
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3.10 1 settaggi autorilevati

Ci sono numerosi oggetti che sono rilevati quando lanciate Options> Reconfigure.
In questa sezione elencheremo quelle che si riferiscono a lyxrc. Quello che
segue, tutte le chiamate *_command sono sono settete a “niente” se non viene
stato trovato il comando opportuno. In questo caso, la corrispondente funzione
non é disponibile.

\latex_command ¢ settato su un processore IXTEX 2¢ valido (programmi testati
sono latex e latex2e).

\ps_command ¢ settato su gs se avete Ghostscript installato.

\view_ps_command é settato su gv o ghostview se sono stati trovati nel sistema
(\view_pspic_command ¢é settato per usare lo stesso programma).

\plaintext_roff_command usa groff oppure nroff-+tbl, a seconda di quello
disponibile.

\chktex_command é settato su chktex con in piit una serie di opzioni.

\fax_command ¢é settato su fax send o sendfax, che dipende da che packetto
fax e stato trovato. Le necessarie opzioni del commando vengono anche
aggiunti.

\print_spool_command viene settato to 1lp su sistmi (chiamati System V) che
hanno questo commando e 1pr altrimenti (sistemi BSD).

\print_spool_printerprefix viene settatoa -d o su -p aseconda della pre-
senza di 1p o lpr.

\font_encoding ¢é settato su T1 se i fonts ec sono rilevati e M TEX ha un sup-
porto interno per questi fonts. Potete settarli manualmente se avete i
cosiddetti fonts dc.

3.11 1l resto

Ci sono molti altri comandi lyxrc che possono essere usati per personalizzare il
comportamento di LyX. Abbiamo attualmente ancora necessita di documentarli
in questa sede, ma ancora, il file lyxrc.example é riccamente commentato, cosi
consigliamo di dare un’occhiata per avere un’idea di quello che potete persona-
lizzare. Potete infine tentare la fortuna nella Guida di RIferimento, ma non ci
sono garanzie dato che & molto difficile tenerla aggiornata.
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Capitolo 4

Il Server IyX

4.1 Introduzione

11 server IyX & un metodo implementato in LyX che abilita altri programmi a
parlare con LyX, a chiamare comandi LyX e ad ottenere informazioni sullo stato
interno di IyX. E’ uno strumento principalmente indirizzato ad utenti esperti,
che dovrebbero trovarlo utile.

4.2 Iniziare il Server LyX

11 server LiyX lavora attraverso 1'uso di un paio di canali. Queste sono di solito lo-
cate nella vostra directory home e si chiamano “.1lyxpipe.in” e “.lyxpipe.out”.

I programmi esterni vanno a scrivere in . lyxpipe.in e leggei datida .lyxpipe.out.
L’inizio di questi canali puod essere specificato nel file 1lyxrc aggiungendo una
linea del tipo:

\serverpipe "/home/myhome/.lyxpipe"

LyX aggiungera’. in’ and . out’ per creare i canali. La precedente riga ha inoltre
Peffetto di attivare il server LyX. se uno dei canali gia esiste, LyX assumera che
c’é un altro processo LyX in esecuzione e non lascera partire il server. Per avere
molti processi IiyX con rispettivi servers in contemporanea, dovete cambiare il
lyxrc tra gli inizi dei programmi.

Se state sviluppando un programma client, potreste trovare utile abilitare
una modalita di debugging dal server IyX. Potete farlo facendo partire LyX
con lyx -dbg 8192.

Attenzione: se LyX va in crash, non pud gestire la rimozione dei canali, e
quindi bisognera farlo manualmente. Se LyX parte e i canali sono gia esistenti,
non fard partire alcun server.

Potete trovare degli esempi completi scritti in C nella distribuzione dei codici
come development/server_monitor.c.

27
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4.3 Comunicazione normale

Per assegnare una chiamata LyX, il client scrive una riga di codice ASCII nel
canale di input. Questa linea ha il seguente formato:

LYXCMD:clientname:function:argument

In questo caso clientname é un nome che il client puo scegliere arbitrariamente.
11 suo unico uso € che LyX gli rispondera se questi manda una risposta - cosi un
client pud mandare risultati da differenti richiedenti.

function & la funzione che volete che LyX esegua. E’ lo stesso dei comandi
che dovreste usare in minibuffer.

argument € un argomento opzionale rilevante solo per alcune funzioni ( ad
esempio “auto-inserimento” che inserisce ’argomento come testo nella posizione
del cursore.)

La risposta da LyX arrivera nel canale di output e sara del tipo

INFO:clientname: function:data

Dove clientname e function sono richiamati dalla richiesta di comando, mentre
data & un’informazione pitt 0 meno utile a seconda dell’esecuzione del comando.
Alcuni comandi restituiscono informazioni circa lo stato interno di LyX, come
il “font-state”, mentre altri restituiscono risposte “vuote”. Questo significa che
I’esecuzione del comando ha avuto fine.

In caso di errori, la risposta da LyX avra questa forma

ERROR:clientname:function:error message

dover I'error message dovrebbe contenere la spiegazione del perche il comando
é fallito.
Esempi:

echo "LYXCMD:test:beginning-of-buffer:" >~/.lyxpipe.in
echo "LYXCMD:test:get-xy:" >7/.lyxpipe.in

read a <7/.lyxpipe.out

echo $a

4.4 Notifica

LyX puo notificare ai clients gli eventi asincroni. Correntemente lo fara soltanto
se 'utente assegna una sequenza di tasti alla funzione “notifica”.
I1 formato della stringa che LyX manda é:

NOTIFY: key-sequence
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dove key-sequence é la rappresentazione stampata della sequenza di tasti pre-
muta dall’utente.

Questo meccanismo puo essere usato per estendere il set di comandi LyX ed
implementare macro: assegnare una sequenza di tasti a “notifica”, lanciare un
client che ascolta sul canale d’uscita, fornisce il comando relativo alla sequenza e
inizia una funzione che puo usare le chiamate e le richieste di LyX per assegnare

un comando o una serie di comandi a LyX.

4.5 11 Protocollo Server LyX semplice

Lyx implementa un semplice protocollo che puo essere usato per la gestione delle
sessioni. Tutti i messaggi sono della forma:

LYXSRV:clientname:protocol message

dove protocol message pud essere “hello” o “bye”. Se “hello” é ricevuto da
un client, LyX ritornera indietro per informare il client che sta ascoltando il
suo messaggio, mentre “bye” mandato da LyX informa i clients che LyX sta
chiudendo.
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Capitolo 5

Internazionalizzare LiyX

Ly X supporta l'uso di interfacce tradotte. L’ultima volta che abbiamo control-
lato, LyX forniva testi in 14 linguaggi diversi oltre 'inglese di base. Il linguaggio
scelto é definito linguaggio locale. (per ulteriori letture sui settaggi locali, ri-
ferirsi alla documentazione del vostro sistema operativo. Per Linux, le manual
page di locale(5) sono un ottimo punto di partenza).

Notate che queste traduzioni funzionano, ma contengono alcuni difetti. In
particolare, tutti i menu di pop-up sono stati progettati in inglese, questo signifi-
ca che alcune traduzioni potrebbero essere troppo grandi rispetto allo spazio ad
esse assegnate in fase di progettazione. Questo é solo un problema di visualizza-
zione che non causa molti problemi. Inoltre, potrete notare che che molte delle
traduzioni non definiscono le scorciatoie per tutto. A volte , molto semplice-
mente, non ci sono abbastanza lettere disponibili. Altre volte, il traduttore non
lo ha ancorafatto. Cercheremo di ovviare a questi inconvenienti nelle prossime
versioni di LyX.

5.1 Selezionare un linguaggio alternativo per ’in-
terfaccia utente

Questa possibilita é disabilitata di default, cio significa che il testo sara in inglese.
Per abilitare un linguaggio alternativo bisogna settare la variabile ambientale
appropriata. Usate "setenv LANG xx" per le interfacce di classe csh o "export
LANG=xx" per la classe sh. Sostituite le xx con il codice di due lettere del
linguaggio che volete. Ad esempio no é Norvegiese.

Evidenetemente vorrete mettere la linea appropriata in ~/.Xsession or
~/.xinitrc in modo che la traduzione sia attivata di default. Ricordate che se
LyX & configurato e compilato con “--disable-nls”,questo non funzionera.
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5.2 Usare scorciatoie per linguaggi alternativi

Una causa principale di inconsistenza nelle versioni tradotte di LyX é il fatto
che tutte le scorciatoie da tastiera per le funzioni del menu sono basate sulla
versione inglese del testo Ad esempio, 'entrata nel menu M-f t aprira il popup
nuovo-file-da-template. Questo é semplice da cambiare, come tutte le scorcia-
toie delle operazioni del menu definite nel file unico LyXDir/bind/menus.bind.
Ogni utente pud avere la propria copia di questo file nella propria directory
privata ~/.lyx/bind, che avra precedenza rispetto agli altri file di sistema. In
questa copia privata ognugno puo facilmente cambiare le definizioni, ad esempio
per la versione tedesca avremo M-f t in M-d v (per Date>Vorlage). Per alcu-
ni linguaggi, gli esempi per adattare i files menus.bind si possono trovare in
LyXDir/bind/xx_menus.bind (xx ¢é il codice del linguaggio). Questi, se esisto-
no (e se il vostro settaggio locale & $LANG=xx), saranno automaticamente usati
da LyX.

Dovete fare attenzione a che le nuove definizioni per le scorciatoie non coinci-
dano con altre prima definite. Ad esempio, I’associazione M-d v generera un erro-
re per quelli che usano (x)emacs.bind, dove M-d é unito a word-delete-forward.

Dalla versione 1.0 di IyX, i nomi tradotti per i menu top level (tradotti nei
files “p0”) sono usati dal meccanismo di assegnazione, quindi il menu tradotto
deve essere usato nel menus.bind tradotto.

5.3 Tradurre IyX

5.3.1 Tradurre interfaccia grafica utente (messaggi di te-
sto).

LyX usa la libreria GNU gettext per gestire 'internazionalizzazione dell’inter-
faccia. Per far parlare a LyX il vostro linguaggio preferito in tutti i menu e le
caselle di diagolo, avete bisogno di un po-file per quel determinato linguaggio.
Quando questo é reperibile, dovrete creare da questi un mo-file ed installarlo.
Tutti i passaggi necessari ad eseguire questa operazione sono spiegati nella do-
cumentazione di GNU gettext, ma, in breve, questo ¢ quello che dovete fare (xx
rappresenta il codice del linguaggio):

e Copiare LYX-SOURCE-DIR/po/lyx.pot in xx.po (se lyx.pot non esiste,
puo essere rifatto con make lyx.pot in quella directory, oppure potete
usare un po-file esistente per altri linguaggi come se fosse un template).

e Editare xx.po!. Per alcune etichette di menu, ci sono anche scorciatoie
da tastiera che dovrebbero essere tradotte. Questi tasti sono segnati dopo
un ‘|’, e dovrebbero essere tradotti in relazione alle parole e alle frasi del
linguaggio xx. C’¢ uno strumento chiamato scgen.pl scritto in Prolog
in LYX-SOURCE-DIR/development/tools/ che pud essere utile per creare

IRaccomandiamo di usare Emacs per fare questo, dato che la distribuzione gettext include
un appropriato supporto.
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determinate scorciatoie. Notate che XForms (almeno la versione 0.86) non
pud manipolare altro che scorciatoie di caratteri di 7 bit. Dovreste inoltre
aggiungere delle informazioni all’inizio del nuovo file po come il vostro
indirizzo email ecc, cosi gli altri sanno dove possono rintracciarvi.

e Create xx.mo. Questo puo essere fatto con
msgfmt -o XX.mo < XX.po

e Copiare ilfile mo nella vostra directory locale, precisamente nella dirctory
dei messaggi dell’applicazione per il linguaggio xx, e, sotto il nome lyx.mo
(es. /usr/local/share/locale/xx/LC_MESSAGES/lyx.mo)

Aggiungere un nuovo file po alla distribuzione di LyX comprende il cam-
biamento degli script di configurazione ed oltre, ma per come lavora gettext,
attualmente non avete bisogno di codice IyX per tradurlo—se si ha 1yx.pot (o
un file po esistente), bastano gli strumenti di gettext.

Se avete scritto un file di traduzione per un linguaggio che attualmente
IyX non supporta, ritenetevi liberi di introdurlo magari mandando una pat-
ch. In questo caso vi raccomandiamo di leggere il README della directory
LYX-SOURCE-DIR/po/ per ulteriori informazioni.

5.3.2 Tradurre la documentazione.

La documentazione online (nel menu Help) puod (e dovrebbe!) essere tradotto.
Se ci sono versioni tradotte della documentazione disponibile?, e il locale é
adeguatamente settato, queste saranno usate automaticamente da LyX. LyX
cerca di tradurre le versioni come LyXDir/doc/xx_DocName.1lyx, dove xx indica
il linguaggio settato dalla variabile ambientale $LANG. Se non c’é nulla, sara
mostrato il linguaggio di default ovvero 'inglese. Notate che le versioni tradotte
devono avere gli stessi nomi dei files come gli originali (DocName di cui sopra).
Se ve la sentite di tradurre la documentazione (un buon modo per leggersi la
documentazione originale BTW!), ci sono alcune cose che dovreste fare:

o Leggere DocStyle.lyx, la guida per scrivere documentazione su LyX. Fare
molta attenzione alla sezione traduzioni.

e Controllare la pagina web delle traduzioni The LyX Developer’s Web Si-
te http://www.devel.lyx.org. In questo modo potete trovare (se ce ne
sono) i documenti tradotti e quelli da tradurre. Inoltre troverete un re-
sponsabile organizzatore (se c’¢) che vi aiutera nella vostra opera. Se non
c’é un organizzatore fateci sapere se siete interessati.

Una volta che iniziate a tradurre ci sono alcune cose che dovete ricordare:

2Ad Aprile 1999, quasi tutti i documenti sono stati tradotti in tedesco. Tl tutorial & stato
tradotto in francese, polacco, portoghese e svedese, con altre traduzioni in corso. La libreria
dei documenti tradotti cresce rapidamente.
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Unirvi al team di documentazione! Ci sono informazioni su come far-
lo in Intro.lyx (Help paese. Inventare una vostra propria terminologia
potrebbe solo creare confusione al lettore. (Attenzione! La tipografia da
assuefazione!)

Fate una copia del documento. Questo sard la vostra copia di lavoro.
Potrete inoltre usarla come vostra copia personale tradotta mettendola
nella vostra directory ~/.lyx/doc/.

Qualche volta il documento originale (dal team LyX) viene aggiornato.
Usate lo strumento CVSweb reperibile presso il sito dello sviluppatore per
vedere i cambiamenti avvenuti®. In questo modo potrete facilmente vedere
le parti del documento che vanno aggiornate.

Se per caso trovate un errore nel documento originale, correggetelo e co-
municate al documentation team i cambiamenti! (non avete dimenticato
di unirvi al documentation team vero?).

5.4 Supporto Tastiere Internazionali

Nota dell’editore: la sequente sezione é a cura di Ivan Schreter. Necessita di
essere corretta in relazione al nuovo Documentation Style ed al fine di utilizzare
le caratteristiche della versione 1.0. Il tutto va inoltre unito con le sezioni
successive.-jw

5.4.1 Definire una propria Mappa della Tastiera: Formato

File Keymap

Diamo uno sguardo al file di definizione della tastiera piu da vicino. E’ un file
di testo ASCII che definisce

o key-to-key or key-to-string translations
e dead keys

e dead keys exceptions

Per definire una traduzione tasto a tasto o tasto a stringa, usare questo comando:

\kmap key outstring

dove key ¢ il tasto che deve essere tradotto e outstring é la stringa che deve
essere inserita nel documento. P er definire i tasti morti, usare:

\kmod key deadkey

3 Alternativamente, potete procurarvi una copia dell’ultima versione del documento inglese

che avete tradotto.
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dove key ¢ il tasto della tastiera e deadkey ¢ il nome del tasto morto. Sono
supportati i seguenti tasti morti (le scorciatoie sono tra parentesi):

Name Ezample
acute (acu) aéioa
grave (gra) agiou
macron (mac) )
tilde (til) iN
underbar (underb) o)
cedilla (ced) ¢C
underdot (underd) )
circumflex (circu) aeiot
circle (circl) AaU
tie (tie) \t oo
breve (bre) 30
caron (car) ¢,
hungarian umlaut (hug) 61
umlaut (uml) aot
dot (dot) VAS

Dato che in molte tastiere internazionali ci sono delle eccezioni alle funzioni di
alcuni tasti morti, potete definirli usando

\kxmod deadkey key outstring

Ad esempio, sulle tastiere slovacche se immettete “caron-o0”, verra scritto “circumflex-
0”, cosi dovrete cambiare

\kxmod caron o "\"o"

per farlo funzionare correttamente. Inoltre, dovrete definire come eccezione i
tasti morti su i e j , per rimuovere il punto prima di inserire un accento. Lo
cambierd appena possibile in quanto non ho ancora avuto il tempo.

Circa i caratteri, backslash non é presente, quindi per inserirlo avete bisogno
del doppio backslash. Inoltre virgolette e # hanno differenti significati. #
segna i commenti, le virgolette iniziano e finiscono i comandi in stile W¥TEX. Per
immettere le virgolette dovete usare \", per #, usare \#.

Se create un file di descrizione della tastiera che va bene per la vostra lin-
gua, vi prego di mandarmelo, in modo che io possa includerlo nella prossima
distribuzione delle mappe di tastiera.

Molte parole chiave saranno presenti nelle future distribuzioni come:

e \kinclude filename include un altro file
e \kprog program define un programma esterno di traduzione della
tastiera

Inoltre dovrebbe apparire nel file lyxrc di default (ad esempio un’opzione
\kinclude per includere la tastiera di default).
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5.5 Materiale sulle tastiere internazionali

Le prossime due sezioni descrivono la sintassi dei file .kmap e . cdef nel dettaglio.
queste sezioni dovrebbero aiutarvi a disegnare la vostra mappa di caratteri se
quelle che avete non vi soddisfano.

5.5.1 11 File .kmap

Un file .kmap mappa le pressioni dei tasti sia di caratteri che di stringhe. Come
suggerisce il nome, esso setta la mappa della tastiera. 1l file .kmap contiene delle
parole chiavi come kmap,kmod,ksmod, e kcomb qui di seguito descritte.

kmap Mappa il carattere rispetto a una stringa
\kmap char string

Questo mapperd char in string. Notate che in string, le due virgolette (") e il
backslash (\) devono essere evitate con un precedente backslash (\).
Un esempio di kmap che serve affinché il simbolo / venga generato dal tasto

& é:
\kmap & /

kmod Specifica un carattere accentato
\kmod char accent allowed

Questo fara si che il carattere char sia accentato sul carattere ammesso. Questo
¢ un meccanismo di tasto morto* .

Se premete char e poi una altro tasto non in allowed (non permesso) avrete
un char seguito da un altro tasto, non abilitato. Ricordate che un Backspace
cancella un tasto morto, cosi se premete char Backspace, il cursore non andra
una posizione indietro, bensi cancellera l’effetto che il char dovrebbe avere sul
tasto successivo.

Il seguente esempio specifica che il carattere * dovra essere un accento acuto,
abilitato sui caratteri a, e, i, o, u, A, E, I, O, e U:

\kmod ’ acute aeiouAEIQU
ksmod Specifica un’eccezione al carattere accentato

\kxmod accent char result

411 termine tasto morto si riferisce ad un tasto che non produce un carattere da solo, ma,
soltanto quando é seguito da un altro tasto. Ad esempio, si pud riprodurre un carattere
tedesco con un umlaunt come d.
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Questo definisce un’eccezione per I'accent sul char. L’accent deve essere stato
assegnato ad un tasto con una precedente dichiarazione \kmod e char non deve
appartenere al set degli accenti (accent) abilitati (allowed). Quando immettete
la sequenza del carattere accentato (accent char sequence), il risultato (result)
viene prodotto. Se non esiste una dichiarazione nel file.kmap e voi immettete
I’accent char, avrete un’accent_key char dove accent_key € il primo argomento
della dichiarazione \kmod declaration.

La seguente procedura di comandi fa in modo che venga generato &i immet-
tendo acute-i (’i):

\kxmod acute i "\\’?{\\i}"
kcomb Combina due caratteri accentati
\kcomb accentl accent? allowed

Questo effetto ha qualcosa di esoterico. Infatti vi permette di combinare ’effetto
di accentl e accent2 (in quell’ordiner!) su caratteri abilitati (allowed). I tasti
per accentl e accent? devono essere stati settati con un comando \kmod in un
punto precedente del file.

Consideriamo questo esempio dal file greek.kmap:

\kmod ; acute aeioyvhAEIOYVH \kmod : umlaut iyIY \kcomb acute

Questo vi permette di premere ;:i ed ottenere I'effetto di \’{\"{i}}. Un back-
space in questo caso cancella I'ultimo tasto morto, cosi se premete ;: Backspace
i avrete \’{i}.

5.5.2 1l file .cdef

Dopo la mappatura fatta con . kmap, il file . cdef mappa le stringhe che i symboli
generano rispetto ai caratteri del font corrente. La corrente distribuzione di LyX
include almeno i files 1s08859-1.cdef e is08859-2. cdef.

In generale il file .cdef é una sequenza di dichiarazioni di questa forma:

char_index_in_set string

Ad esempio, per mappare \'{e} sul corrispondente carattere nel set is0-8859-1
(233), si usa la seguente dichiarazione

233 "\\’{e}"

con \ e " estranei alla stringa. Notate che lo stesso carattere puo essere applicato
a piu di una stringa. Nel file is0-8859-7.cdef avete

192 "\\?{\\\"{i}}"
192 "\\\"{\\"{i}}"

Se LyX non trova una mappatura per la stringa prodotta dalla pressione del
tasto o da una sequenza con tasti morti, controllera se assomiglia ad un carattere
accentato e provera a disegnare un accento sul carattere sullo schermo.

umlaut iyIY
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5.5.3 Tasti morti

C’¢ un altro modo per aggiungere il supporto a caratteri internazionali, ed &
quello che usa la tecnica dei cosiddetti tasti morti. Un tasto morto lavora in
combinazione con una lettera per produrre un carattere accentato. In questa
sezione spieghiamo come si crea un semplice tasto morto per far vedere come
funziona.

Supponiamo di avere bisogno di un carattere circonflesso, “~”. Si potrebbe
associare il tasto ~ [a.k.a. Shift-6] al comando LyX accent-circumflex nel
vostro file 1yxrc. Ora, se digitate il tasto ~ seguito da una lettera, la lettera
avra un accento circonflesso su di essa. Per esempio, la sequenza “~e” produce
la lettera e con ~. Se provate a digitare “~t”, tuttavia, IyX segnalera con
un beep che 'operazione non ¢ possibile dato che la t non ha mai accento.
Premere Spazio dopo un deadkey produrra un accento semplice. Attenzione a
quest’ultimo punto! Se associate un tasto ad un deadkey, dovrete riassociare il
carattere su quel tasto ad un altro tasto ancora.

Un altro modo comune di associare tasti morti ¢ quello di usare Meta-,
Ctrl-, e Shift- in combinazione con un accento come “~” o “” o “*”. Un’altra
tecnica consiste nell’'uso di xmodmap e xkeycaps per settare il tasto speciale
Mode_Switch. Il Mode_Switch si comporta in alcuni casi proprio come lo Shift
e permette di associare tasti a caratteri accentati. Potete inoltre convertire
tasti semplici in tasti morti associandoli ad oggetti del tipo usldead_cedilla e
successivamente, associando questo tasto simbolico al corrispondente comando
LyX.5 Potete fare pressocché tutto con il tasto Mode_Switch: uno dei tasti
Ctrl-, una funzione libera, ecc. Come per i comandi IyX che producono accenti,
consultate il Manuale di Riferimento per 'accento acuto. Troverete li la lista
completa.

5.5.4 Salvare la vostra configurazione di Linguaggio

Potete editare il vostro file 1yxrc in modo che il linguaggio da voi preferito sia
configurato e caricato automaticamente allo startup di LyX. Questa sezione
descrive i comandi lyxrc da specificare:

e default, primary, and secondary keymaps
e character set

Guardate il vostro file lyxrc per i vari esempi su come configurarlo. In parti-
colare, potete settare una keymap cosi:

\kbmap true
\kbmap_primary german
\kbmap_secondary american

5Nota da Joun WEIss: Questo é esattamente quello che faccio nei miei files ~/.1yx/lyxrc
e ~/.xmodmap. Ho il mio tasto Scroll Lock settato come Mode Shift e un sacco di questi tasti
simbolici “usldead #" che consentono di ottenere cose del tipo Scroll Lock-~ e Scroll Lock-".
Questo é il modo in cui genero i miei caratteri accentati.
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e una font-mapping (.cdef file) in questo modo:

\screen_font_encoding iso08859-2

39
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Capitolo 6

Installare Nuove Classi di
Documento, Layouts e
Templates

In questo capitolo si descrivono le procedure per creare ed installare nuovi lay-
outs di LyX e files template, come anche si procedera ad illustrare la corretta
installazione di nuove classi di documento WTEX. Alcune definizioni: una classe
di documento ¢ un file BTEX (che di solito hanno estensione in .cls o .sty)
che descrive il formato di un documento come un articolo, report, prestampa di
giornale, ecc. e tutti i comandi di cui si ha bisogno per realizzare quel formato.
Un file layout & un file IyX che corrisponde ad una classe di documento BTEX
e che dice a IyX come “disegnare” le cose sullo schermo in modo da rendere le
cose il pitu possibile vicine alla pagina finale stampata. Pitl precisamente, un file
layout descrive una “textclass” che é il costrutto interno che LyX usa per fare
il rendering dello schermo. “Layout” e “textclass” possono a volta essere usate
come sinonimi, ma é meglio riferirsi al file come il layout, e all’oggetto residen-
te nella memoria di LyX come textclass. Un file template é semplicemente un
documento LyX che contiene un set di righe predefinite per una data classe di
documento che sono generalmente richiesti per quella classe. I templates sono
in particolare utili per cose come i manoscritti di giornale che devono essere
processati elettronicamente.

6.1 Installare un nuovo pacchetto ITEX

Alcune installazioni possono non includere un pacchetto IATEX che vorreste usare
in IyX. Ad esempio, vorreste avere FoilTEX, un pacchetto comune (e molto
potente) per preparare slides o grafici per capiprogetto.! Ecco di seguito tutti i

Vedere il manuale Extended LyX Features per ulteriori informazioni su Foil TEX
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passaggi necessari per avere il pacchetto e lanciarlo se si usa una recente versione
di teTEX? o altre distribuzioni basate su web2c.

1. Procurarsi il pacchetto da CTAN o simili.?

2. Leggereil file texmf . cnf (che di solito risiede nella directory $TEXMF/web2c,
sebbene possiate lanciare kpsewhich texmf.cnf per localizzarlo). Questo
descrive come aggiungere una directory locale texmf; seguire le istruzioni.
Avete bisogno di inserire il nome della vostra directory locale texmf in
texmf.cnf. Sotto Linux, /usr/local é una posizione logica dove instal-
lare software che non é presente nelle normali distribuzioni, cosi dovete
usare /usr/local/texmf. Di solito dovete modificare solo due cose:

(a) Settare TEXMFLOCAL sulla directory che avete scelto; es.
TEXMFLOCAL = /usr/local/texmf

(b) Assicuratevi che TEXMF includa la variabile TEXMFLOCAL variable; es.
TEXMF = {$HOMETEXMF, ! !$TEXMFLOCAL, ! !$TEXMFMAIN}

3. Create la vostra directory locale texmf (es. /usr/local/texmf). Dovete
seguire la struttura dell’esistente directory texmf (ad esempio, i pacchetti
latex dovrebbero andare sotto /usr/local/texmf/tex/latex/).

4. Installare il pacchetto. Ad esempio, vogliamo scompattare ’archivio Foil TgX
e creare /usr/local/texmf/tex/latex/foiltex. La directory foiltex
contiene vari files.

5. Lanciare: texhash. Questo dovrebbe creare /usr/local/texmf/1s-R tra
le altre.

6. Dall'interno di LyX, fate: Options> Reconfigure. Riavviate LyX.

Ora dovreste vedere il vostro nuovo pacchetto—ad esempio slides (Foil TEX)—sotto
Layout > Document, campo Class. Notate che ci sono modi piti semplici per in-
stallare pacchetti: potete aggiungere un link alla nuova directory del pacchetto
nella directory di sistema ITEX ($TEXMF/tex/latex, non dimenticate di lan-
ciare dopo texconfig), o qualche volta basta semplicemente settare la variabile
ambientale STEXINPUTS per includere un nuovo pacchetto. Tuttavia, la pro-
cedura formale descritta in texmf.cnf é garantito che funzioni, cosi dovreste
provare a seguirla fino a che se ne ha la possibilitd (che potrebbe perdersi se
non si ha accesso da superuser).

2Questa procedura é definitivamente valida per la versione v1.0 e tutte le versioni beta,
v0.9. Commenti sul funzionamento per le versioni v.04 sono graditi, anche se é comunque
preferibile aggiornarsi alla versione v1.0.x.

3Vedere il manuale Inventory of your IATEX configuration per i dettagli su cosa é CTAN
e dove possono essere trovate le classi di documento supportate.
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6.2 Layouts

Questa sezione descrive come scrivere ed installare i propri files di layout di LyX
(anche detti textclass), utilizzando la textclass article come esempio. I files
.layout descrivono quali stili di paragrafi sono disponibili per una data classe di
documenti e come LyX dovrebbe mostrarli. Proveremo qui a fornire un’accurata
descrizione del processo; tuttavia, ci sono cosi tanti tipi di documenti suppor-
tati dalle classi 'TEX da renderci impossibile fornire una descrizione esaustiva
dell’argomento e delle possibilita che si possono manifestare.

Quando programmate di scrivere un nuovo layout, & estremamente utile
guardare prima i layout di esempio distribuiti con LyX. Se usate una classe di
documento ITEX particolarmente bella che puo essere di interesse anche per
altre persone e che abbia un buon corrispondente layout in LyX, siete liberi di
mandarcelo in modo da poterlo inserire nella distribuzione.

Tutte le righe di codice di questo paragrafo sono case-insensitive; cid signi-
fica che Style, style e StYle sono lo stesso comando. I possibili valori sono
scritti tra parentesi dopo il nome della caratteristica. Il valore di default se
una caratteristica non é specificata nella descrizione della textclass é scritto in
corsivo. Se largomento € un tipo di dati come “string” o “float”, il valore di
default & scritto come float=default.

6.2.1 Supportare nuove classi di documento

Ci sono tre situazioni che potete incontrare se volete supportare una nuova
classe di documento WTEX. I due tipi pit semplici coinvolgono classe (.cls) e
style (.sty) IWTEX 2¢. Se siete sfortunati potreste incappare nella terza situazione
di supportare un file di stile ETEX 2.09. Il processo di creazione di un file di
layout per queste tre situazioni € simile; tuttavia un passo in piu é richiesto per
permettere a LyX di usare IATEX 2.09.

6.2.2 File sty LaTex2e

Se la vostra nuova classe di documento é sotto forma di style file, usato in
aggiunta ad uno esistente, la classe di documento supportata, inizia copiando il
layout della classe esistente nella vostra directory locale. A causa della mancanza
di esempi assumeremo che il file style si chiami myclass.sty e sard usato con
report.cls con una classe standard.

cp report.layout ~/.lyx/layouts/myclass.layout
Poi editiamo myclass.layout e cambiamo la linea:
\DeclareLaTeXClass{report}

in modo da avere

\DeclareLaTeXClass[report, myclass.sty]{report (myclass)}
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Poi aggiungiamo:
Preamble \usepackage{myclass}EndPreamble

presso l'inizio del file.

Lanciamo LyX e selezioniamo Options > Reconfigure. Riavviamo LyX e pro-
viamo a creare un nuovo documento. Dovreste vedere “report (myclass)” come
una classe di documento opzione nel menu Layout> Document. E’ probabile che
alcuni dei comandi di sezionamento ed altri differiscano dal modo di lavorare
delle classi base*, cosi potrete giocare con i settaggi per le differenti sezioni se
vorrete. In seguito 'argomento sara ripreso.

6.2.3 File cls BPTEX 2¢

In questo caso, dovrete “vedervela da soli” con il vostro layout. Raccomandiamo
fortemente di copiare un file di layout esistente che usa una classe di testo I TEX
simile e modificarlo per quanto possibile. oppure si pudé almeno usare un file
esistente come punto di partenza in modo da capire quali oggetti servano ai
vostri scopi. Ancora, pitl avanti ci saranno altri dettagli.

6.2.4 File sty BETEX 2.09

Se il file .sty ¢é specifico per 'ormai defunto ITEX 2.09 potete stabilirlo attra-
verso uno di questi due modi:

1. Un file di esempio o la documentazione nel file sty stabilisce 1'uso con
\documentstyle{myclass} (opposto a \documentclass).

2. Lanciare BTEX su un file di esempio produrra un banner con l'avverti-
mento che si sta entrando nel “compatibility mode”.

LyX tecnicamente supporta solo documenti I'TEX 2. Ma non mollate ancora!

Dove c’¢ volonta c¢’¢ un modo ( oppure “adattarsi ¢ impossibile, ma ’abbiamo

comunque fatto.”). Il supporto esistente per ReVTEX 3.1, ad esempio, com-

prende il codice 2.09 da usare nei documenti formattati 2e. Potete riutilizzare

ladattatore ReVTEX per la vostramyclass. sty (se risulta essere di codice 2.09).
Bene, ecco cosa dovete fare:

cp LyXDir/tex/revtex.cls ~/tex/myclass.cls

oppure dove avete i vostri files locali TEX. Ora editate myclass.cls e fate
un trova-e-sostituisci tra “revtex” e “myclass”. E’ probabile che alcune delle
dichiarazioni \DeclareOption nel file non sono rilevanti per il vostro file di
stile, ma non ci interessano per il momento.

Il prossimo passo € quello di ripetere il processo di creazione del file di layout
myclass.layout di prima; solo per questa volta usate:

4Report nell’esempio
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\DeclareLaTeXClass{myclass}

e non dovreste aver bisogno di definizioni di tipo Preamble. Lanciate LyX e
riconfigurate, riavviate IyyX e con un po di fortuna avrete un sistema che ha
bisogno solo di qualche accorgimento allo schermo e null’altro. Questo implica
il manipolare dei valori usati da LyX per lo spazio, lo stile dei fonts e le altre
cose definite nei files .layout.

Avrete inoltre bisogno di controllare che avete tutte le variabili d’ambiente da
myclass.sty disponibili nel file myclass.layout. Se mancano alcune bisognera
inserirle. Copiate un altro stile che sembra simile e modificatelo. Il modo piu
semplice per farlo é con:

Style MissingStyle

CopyStyle SimilarStyle

# whatever is different you now redefine
End

Guardare in seguito per i dettagli circa quello che fa ogni elemento nel file
.layout.

Dovrebbe essere abbastanza per mettervi sulla giusta strada. Fate riferi-
mento alle successive sezioni per i dettagli sui contenuti attuali dei files layout e
ricordate che se ci sono problemi potete chiedere aiuto alla mailing list di LyX.
Siamo sempre lieti di avere nuove classi di documento.

6.3 Dichiarare una nuova textclass

Quando é finalmente giunta 'ora di sporcarvi le mani e creare un vostro perso-
nale file di layout, la seguente sezione descrive a cosa andrete incontro. Il nostro
consiglio é di procedere piano, salvare e testare spesso, ascoltare musica soffusa
e bere un paio di bevande per adulti che gradite; qualcuna in pit se siete parti-
colarmente disorientati. Non é molto difficile, eccetto per la moltitudine di op-
zioni che possono creare problemi se cercate di molte cose contemporaneamente.
Andate a prendervi un’altra bibita, solo per precauzione.

Andiamo!

Le linee in un file di layout che iniziano con # sono commenti. C’¢ una
eccezione a questa regola: tutti i layouts dovrebbero iniziare con queste linee:

#% Do not delete the line below; configure depends on this
# \DeclareLaTeXClass{article}

La seconda linea é usata quando configurate LyX. 1l file di layout € letto dallo
script I¥TEX chkconfig.ltx, in un modo speciale e tale che # venga ignora-
to. La prima linea é solo un commento IATEX, e la seconda contiene la di-
chiarazione della classe di testo. Se queste linne appaiono in un file chiamato
article.layout, definiranno una textclass dal nome article (il nome del file
di layout) che usa la classe di documento WTEX article.cls (Il default ¢ quello
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di usare lo stesso nome del layout). La stringa “article” che appare sopra é usata
come descrizione della textclass nel menu Layout> Document .

Assumiamo che scrivete la vostra texclass utilizzando la classe di documento
article.cls, dove avete cambiato le sezioni di testa. Se lo mettete in un file
myarticle.layout, le intestazioni di questo file dovrebbero essere:

#/ Do not delete the line below; configure depends on this
# \DeclarelaTeXClass[article]{article (with my own headings)}

Questi dichiarano una textclass myarticle, associata con la classe di documento
KTEX article.cls e descritta come “article (con le vostre intestazioni)”. Se la
vostra textclass dipende da molti pacchetti, potete dichiararla come:

#/ Do not delete the line below; configure depends on this
# \DeclarelLaTeXClass[article,foo.styl{article (with my own headings)}

Queste indicano che la vostra textclass usa il pacchetto foo.sty. Infine é anche
possibile dichiarare classi per codice DocBook. Le dichiarazioni tipiche avranno
questa forma:

#/ Do not delete the line below; configure depends on this
# \DeclareDocBookClass[article]{SGML (DocBook article)}

Notate che a queste dichiarazioni puo essere anche dato come parametro opzio-
nale che dichiara il nome della classe di documento (ma non una lista).

Quando la textclass é stata modificata secondo 1 vostri gusti, tutto quello che
dovete fare é copiarla in $LyXDir/layouts/ o in $UserDir/layouts e lanciare
Options> Reconfigure. Chiudete LyX e rilanciatelo; a questo punto la vostra
nuova textclass dovrebbe essere disponibile insieme alle altre.

6.3.1 Parametri generali di textclass

Questi sono i parametri generali che descrivono la struttura dell’intero docu-
mento:

Columns [I, 2] A seconda che la classe di default abbia una o due colonne.
Puod essere cambiato nel menu Layout>Document. Questo settaggio (a
volte si confonde con Sides) ¢ importante: se le vostre textclass hanno
due colonne di default, ma dimenticate di settarlo correttamente, I’'opzione
KTEX twocolumn non sard mostrata quando selezionate Two Columns in
Layout > Document.

Sides [1, 2] A seconda che la classe di default debba stampare su uno o en-
trambi i lati del foglio. Puo essere cambiato nel menu Layout> Document

PageStyle [plain, empty, headings]| La classe di default pagestyle. Puo
essere cambiata nel menu the Layout > Document.
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MaxCounter [Counte'r*_ Chapter, Counter_Section, Counter_Subsection,
Counter_Subsubsection, Counter_Paragraph,
Counter_Subparagraph, Counter_EnumI, Counter_EnumII,
Counter_EnumIII, Counter_EnumIV] Il piu alto livello di enumerazione
automatica. Valori utili sono Counter_Chapter per un libro o un report
e Counter_Section per un articolo. Se non c’¢ bisogno di enumerazione,
ad esempio all’interno di una classe di lettere, MaxCounter dovrebbe
essere settato su Counter_EnumI.

ClassOptions...End Questa sezione descrive varie opzioni globali supportate
dalla classe di documento. Guardare la sezione .

ProvidesAmsmath [0, 1] Se la classe gia carica il pacchetto amsmath. Questo
¢ il caso delle classi di documento amsart e amsbook.

ProvidesMakeidx [0, 1] Se la classe fornisce la funzione del pacchetto
makeidx. Questo € il caso delle classi di documento amsart e amsbook.

ProvidesUrl [0, 1] Se la classe fornisce la funzione del pacchetto url. Questo
¢ il caso della classe di documento AASTeX.

DefaultFont Questo é usato per descrivere il font di default del documento.
Guardare la sezione 6.3.4 per una descrizione.

Preamble. . .EndPreamble Un set di macro definizione che saranno emesse
all’inizio dei files W TEX. Usatelo per definizioni globali.

Input Come implica il nome, questo comando permette di inserire un altro file
di definizione di textclass per evitare una ripetizione dei comandi. Molti
files di textclass, per esempio, mettono stdclass.inc, che contiene molti
dei layouts di base.

NoStyle Questo comando elimina uno stile esistente. E’ particolarmente utile

quando si vuole sopprimere un layout definito in un input file.

6.3.2 Sezione ClassOption

La sezione ClassOption pud contenere le seguenti righe:

FontSize [string="10|11]12"] Una lista delle grandezze dei font disponibili
per il font principale del documento, separato da “|”.

PageStyle [string="empty|plain|headings|fancy"] La lista degli stili di pa-
gina disponibili, separati da “|”.

Other [string=""] Alcune opzioni di classi di documento, separate da una vir-
gola, che sara aggiunta alla parte delle opzioni del comando \documentclass.
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6.3.3 Layouts specifici di paragrafo
La descrizione di un layout description & di questo tipo®:
Style name
End
dove sono consentiti i seguenti comandi:

CopyStyle Questo & usato per copiare tutte le caratteristiche di un layout
esistente in quello corrente.

LatexType [Paragraph, Command, Environment, Item_Environment,
List_Enviromment] Come dovrebbe essere tradotto il lay-

out in KTEX. Paragraph non significa nulla in particolare.
Command  significa \LatezName{...} e Environment significa
\begin{LatezName}...\end{LatexzName}l. Item_Environment ¢é lo

stesso di Environment, eccetto che per \item che é generato per
ogni paragrafo di questo ambiente. List_Environment é lo stesso di
Item_Environment, eccetto LabelWidthString che é passato come
argomento per l'ambiente. LabelWidthString pud essere definito nel
menu Layout > Paragraph.

InTitle [1, 0] Se il valore & 1, segna il layout come necessitante di un
\maketitle.

LatexName Il nome del corrispondente materiale IATEX. Puo essere sia di
ambiente che di comando.

LatexParam Il parametro opzionale per il relativo materiale LatexName. Questo
parametro non puo essere cambiato da LyX.

Margin [Sta.t'llc , Manual, Dynamic, First_Dynamic, Right_Address_Box]
1l tipo di margine che il layout ha sul lato sinistro. Static significa un
margine statico. Manual significa che il margine sinistro dipende dalla
stringa immessa nel menu Layout > Paragraph. Questo é usato per intesta-
zione enumerate automatiche. Dynamic significa che il margine dipende
dalla grandezza dell’etichetta. E’ ovvio che 'intestazione “5.4.3.2.1 Very
long headline” deve avere un margine sinistro pitt ampio (ampio quanto
“5.4.3.2.1”) di “3.2 Very long headline”, anche se altri word processors non
sono in grado di farlo. First_Dynamic é s simile, ma solo la prima riga
del paragrafo é dinamica, mentre le altre sono statiche. usato ad esempio
per le descrizioni. Right_Address_Box significa che il margine é scelto in
modo tale che la riga pit lunga di questo paragrafo arriva fino al margine
destro. Usato per scrivere indirizzi in alto a destra della pagina.

5Notate che questo pud definire un nuovo layout o modificarne uno esistente.
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NextNoIndent [1, 0] Se si vuole consentire al paragrafo successivo di staccare
dal margine la prima riga, 0 consente di farlo, 1 no.

ParIndent [string=""] Il capoverso della prima linea del paragrafo. L’argo-
mento € passato come una stringa. Ad esempio "MM" significa che il pa-
ragrafo rientra con una larghezza di "MM" nel font normale. Potete anche
avere una larghezza negativa premettendo il valore "-". Questo al fine
di ottenere lo stesso effetto per ogni font. Il Parindent sara fisso per un
certo layout. L’eccezione é lo Standard layout, dato che il rientro del pa-
ragrafo di layout standard poo essere proibito con NextNoIndent. Inoltre,
i paragrafi con Standard layout, usano il Parindent dell’ambiente, non il
loro nativo. ad esempio, i paragrafi Standard dentro una numerazione non
hanno il rientro.

Parskip [float=0] LyX permette di scegliere sia il “rientra” che il “salta” per
redigere un documento. Quando si sceglie “rientra”, questo valore é com-
pletamente ignorato. Quando si sceglie “salta” ’indentazione di un layout
“Paragrafo” in stile XTEX é ignorato e tutti i paragrafi sono addizional-
mente separati da questo argomento parskip. Lo spazio é verticale é cal-
colato con valuexDefaultHeight () dove DefaultHeight () é l'altezza di
una riga con il font normale. In questo modo I'aspetto rimane lo stesso
indipendentemente dai fonts.

TopSep [float=0] Lo spazio vericale con cui il primo di una catena di paragrafi
con questo layout é separato dal precedente. Se il paragrafo precedente
ha un altro layout, le separazioni non sono semplicemente ma € preso il
massimo.

BottomSep [float=0] La stessa cosa di TopSep per l'ultimo paragrafo.
Parsep [float=0] Lo spazio verticale tra due paragrafi di questo layout.

Itemsep [float=0] Questo & uno spazio extra tra i paragrafi di un ambiente
di layout. Se immettete altri layouts nello stesso ambiente, ognuno sara
separato con Parsep. Ma la totalita degli oggetti presenti nell’ambiente
sono separati addizionalmente con Itemsep.

LeftMargin [string=""| Se immettete layouts nell’ambiente, i margini sinistri
non sono semplicemente aggiunti, ma aggiunti con un fattore W“hﬁ‘
Notate che questo parametro é usato anche quando il bordo é definito
come Manual o Dynamic. Poi é aggiunto al bordo manuale o dinamico.
Questa stringa ha lo stesso significato di ParIndent.

RightMargin [string=""] Simile a LeftMargin.

Labeltype [No_La,beZ, Manual, Static, Top_Environment,
Centered_Top_Environment, Sensitive, Counter_Chapter,
Counter_Section, Counter_Subsection, Counter_Subsubsection,
Counter_Paragraph, Counter_Subparagraph, Counter_EnumI,
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Counter_EnumII, Counter_EnumIII, Counter_EnumIV]

Manual significa che Petichetta é la primissima parola (lettera). Static
viene definito nel layout (vedere LabelString). Top_Environment e
Centered_Top_Environment sono casi speciali di Static. L’etichetta sa-
ra stampata sopra il paragrafo, ma solo in cima all’ambiente o in cima ad
una catena di paragrafi con questo layout. L’uso é ad esempio il layout
Abstract o il Bibliography. E’ questo anche il caso di etichette Manual con
tipo IWTEX Enviroment, per creare layouts per teoremi messi giu corret-
tamente. Sensitive € un caso speciale per le etichette di testo “Figura” e
“Tabella”. Sensitive significa che la stringa dell’etichetta dipende dal ti-
po di oggetto flottante. I tipi di etichetta Counter_xxx sdivrebbero essere
abbastanza chiare.

Labelsep [string=""] Lo spazio orizzontale tra l’etichetta e il corpo del testo.
Usato solo per etichette che non sono sopra il corpo del testo.

LabelBottomsep [float=0] Lo spazio verticale tra letichetta e il corpo del
testo. Usato solo per etichette che sono sopra il corpo del testo
(Top_Environment, Centered_Top_Environment).

LabelString [string=""]| La stringa usata per un’etichetta del tipo Static.
Quando il bordo & manuale questa stringa é anche usata come suggeri-
mento per LabelWidthString che pud essere settato nel menu Layout>
Paragraph. Quando il tipo label &¢ Counter xxx, questa stringa viene
preposta al contatore.

Align [block, left, right, center] Allineamento del paragrafo.

AlignPossible [block, left, right, center| Sono liste, separate da una
virgola, di possibili allineamenti. Alcuni stili A TEX proibiscono certi alli-
neamenti, dato che questi non hanno senso. Ad esempio una numerazione
allineata a destra o centrata non € possibile.

Fill_Top [0,1] Con questo parametro il valore Fill della lista “Spazi verticali
sopra” del menu Layout®.

Fill_Bottom [0,1] Simile a Fill_Top.

NeedProtect [0,1] Qualora comandi fragili in questo layout necessitassero di
essere protetti \protetti.

Newline [0, 1] Se le nuove linee sono tradotte in nuove linee BTEX (\\) o no.
La traduzione puo essere evitata per facilitare I’editing di I*’TgX all’interno
di TyX.

FreeSpacing [0, 1] Di solito LyX non vi permette di inserire piu di uno spazio
tra le parole, dato che lo spazio é considerato come una separazione tra

S Nota di Jean-Marc: Non sono sicuro che questo settaggio sia molto usato, e sara
probabilmente rimosso nelle versioni successive.
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due parole, non un carattere o un simbolo a se stante. Questa é una
cosa molto simpatica ma a volte annoiante, ad esempio quando si scrive il
codice di un programma o codice IXTEX. Per queste ragioni, FreeSpacing
puo essere abilitato. Notate che LyX creera bianchi protetti per i bianchi
addizionali se in un modo diverso dal modo-IATEX.

KeepEmpty [0, 1] Disolito LyX non vi consente di lasciare un paragrafo vuoto,

dato che porterebbe ad un output KTEX vuoto. Ci sono alcuni casi in
cui perd questo é auspicabile: in un template di lettera i campi richiesti
possono essere rappresentati da spazi vuoti, cosi da agevolare le persone;
in alcune classi speciali, un layout potrebbe essere usato come un tipo di
interruzione, che non contiene testo, ecc.

Spacing [single, onehalf, double, other walue] Questo definisce la spa-

Font

ziatura di default del layout. Gli argomenti single, onehalf e double
corrispondono rispettivamentead un valore multiplo di 1, 1.25 e 1.667. Se
specificate l'argomento other, dovrete poi fornire un argomento numeri-
co che sara ’attuale moltiplicatore. Notate che, contrariamente agli altri
parametri, Spacing implica la generazione di uno specifico codice ITEX,
usando il pacchetto setspace.sty.

11 font usato sia per il corpo del testo che per letichetta. Vedere la sezio-
ne .Notare che definire questo font automaticamente definisce LabelFont
allo stesso valore.

TextFont Il font usato per il corpo del testo. Vedere la sezione 6.3.4.

LabelFont Il font usato per le etichette. Vedere la sezione 6.3.4.

Preamble. . .EndPreamble Un set di macro definizione che saranno emesse al-

I'inizio dei files BWTEX quando il layout é usato. Usatelo per definire le
macro di cui si hanno bisogno per questo particolare layout.

6.3.4 Descrizione dei Font

Una descrizione di un font appare cosi:

Font or LabelFont

EndFont

e i seguenti comandi sono disponibili:

Family [Roman, Sans, Typewriter]

Series [Medium, Bold]

Shape [Up, Italic, SmallCaps]

Size

[tiny, small, normal , large, larger, largest, huge, giant]
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Color [nome, black, white, red, green, blue, cyan, magenta, yellow]

Latex [no_latez, latex|no_latex significa che LyX tradurra tutto in IATEX.
Latex significa una stampata rossa e nessuna traduzione.

6.4 Creare Templates

I templates vengono creati come normali documenti. L’unica differenza é che i
documenti normali contengono tutti i possibili settaggi, inclusi schemi di font e
dimensioni della carta. Di solito 'utente non vuole che il template sovrascriva il
suo default, per questo motivo il progettatore di template dovrebbe rimuovere i
corrispondenti comandi come \fontscheme or \papersize dal file di template
di LyX. Questo si puo fare con un qualsiasi editor di testo come vi o xedit.

Mettete il template editato che avete creato in $UserDir/templates/, copia-
te quello che usate dalla directory globale dei template in $LyXDir/templates/
nello stesso posto, e ridefinite la directory dei template in lyxrc usando il
comando \template_path.



Capitolo 7

Un Tutorial sulla Stampante

7.1 Introduzione

Questo capitolo descrive come sia possibile fare il setup di una stampante sotto
Unix, in modo da poterla usare in LyX. Se avete un sistema Linux, e avete biso-
gno di settare la vostra stampante, potete anche leggere il file Printing-HOWTO
[spesso nella directory /usr/doc/FAQ/HOWTO/ o /usr/doc/HOWTO/ a seconda del
sistema]. Inoltre dovrete installare il pacchetto Ghostscript dal vostro CD-ROM,
se non lo avete ancora o mai fatto.

Alcune distribuzioni Linux attualmente hanno i cosiddetti “filtri magici” che
settano automaticamente il vostro sistema e lo rendono pronto all’uso. Potete
usare questi strumenti in alternativa o in aggiunta a quello che andremo a descri-
vere, anche se i risultati con questi strumenti saranno molto inferiori rispetto alle
rispettive potenzialita. Se la vostra distribuzione ha un tool di configurazione
anche in fase di installazione, potete certamente usarlo, ma dovrete comunque
leggervi il Printing-HOWTO quando vorrete personalizzare il setup.

Cosi, se vi sentite avventurosi, o non avete altra scelta, continuate a leggere!

7.2 1l file /etc/printcap

7.2.1 Descrizione

1l file /etc/printcap é quello che permette di comunicare a Linux i dati della
vostra stampante. Ogni entrata definisce una stampante, le da un nome con
cui gli utenti possono chiamarla, e dice a Linux come gestire il relativo output.
Potete ovviamente avere piu “stampanti” nel vostro sistema anche se gli utenti
accedono ad una stessa stampante fisica, perd con differenti setup o funzioni abi-
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litate.! Naturalmente, avrete bisogno di un’entrata printcap per ogni stampante
fisica che avete.
Ecco un esempio /etc/printcap:

lp|Text on an Epson:\

:1p=/dev/1p1:\

:sd=/var/spool/1lpd/1lp:\
:1f=/var/spool/lpd/1lp/errs:\

1mx#0:\

:sh:\

:sf:

draft|Postscript on an Epson Stylus Color IIs, 180dpi:\
:1p=/dev/1p1:\
:sd=/var/spool/lpd/draft:\
:1f=/var/spool/lpd/draft/errs:\
:if=/var/spool/lpd/draft/draft.filter:\
imx#0:\

:sh:\

:sf:

ps|Postscript on an Epson Stylus Color IIs, 360dpi:\
:1p=/dev/1pl:\

:sd=/var/spool/lpd/ps:\
:1f=/var/spool/lpd/ps/errs:\
:if=/var/spool/lpd/ps/ps.filter:\
1mx#0:\

:sh:\

:sf:

Prima di avventurarci nella spiegazione di questi geroglifici, abbiamo un mes-
saggio importante:

ATTENZIONE! ATTENZIONE! ATTENZIONE!
Usate solo una linea tra le entrate!!!

Assicuratevi che la linea fra le entrate sia COMPLETAMENTE BIANCA!!!

Anche se lasciate uno spazio bianco tra le entrate, possono accadere cose
strane, ed il sistema non interpretera correttamente il file /etc/printcap.

Date uno sguardo ad una delle entrate dell’esempio precedente. Ogni parte
dell’entrata é seguita da un carattere “:“. Il carattere “\” alla fine di ogni linea

INota di Joun WEiss: Io ho una Epson Stylus Color IIs. Quando c’¢ bisogno di cambiare
le testine per usare il colore sulla Stylus IIs, faccio un setup per una stampante separata,
che chiamo color. Ho anche creato una stampante draft che usa una risoluzione di stampa
minore e meno caratteristiche di stampa. Quindi potete intuire la funzionalitd di printcap.
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dice a Linux che 'entrata continua alla riga successiva. Non mettete nulla dopo
il “\”, nemmeno uno spazio. Il “\” dovrebbe seguire il “:* dell’'ultima parte
dell’entrata sulla linea che avete interrotto.

Se scegliete di interrompere un’entrata di printcap in linee multiple, assicu-
ratevi di mettere un “:“ all’inizio del testo della nuova linea, dopo ogni spazio.
Ad esempio, potremmo aver scritto la prima entrata dell’esempio precedente

come:

lplText:1lp=/dev/1lpl:sd=/var/spool/lpd/lp:1lf=/var/spool/1lpd/lp/errs:

Notate che c¢’é un solo “:* tra ognuna delle parti dell’entrata. Se volete dividere
questa entrata in due linee:

lplText:1p=/dev/1lpl:sd=/var/spool/lpd/1lp:\

:1f=/var/spool/lpd/lp/errs:
Abbiamo interrotto la linea al punto “:“ aggiungendo un “\”, e iniziando la
nuova linea che degli spazi e poi un “:* prima di continuare. E’ uso comune
quello di far rientrare la linea successiva di un pochettino in questi casi.

Andremo ora a spiegare ogni parte di un’entrata di /etc/printcap. Notate

che ci sono altre opzioni che potete aggiungere ad un’entrata. Noi ci occuperemo
soltanto delle quattro basi qui, e vi preghiamo di riferirvi alle man page su
printcap per le informazioni addizionali.

7.2.2 11 Nome della Stampante

La prima linea di un’entrata di printcap ¢ il nome della stampante. Contiene
il nome della stampante, seguito da un carattere “|” , seguito da un testo che
descrive la stampante, e infine, naturalmente, il carattere “:“. Ad esempio:

draft|OurPrinter in Draft Mode:\

é una stampante chiamata “draft” con la descrizione “Nostra stampante in
modalita bozza” [Notate che I’ “\” alla fine della linea, indica che continueremo
Pentrata alla riga successiva.] Il nome draft & quello che in genere passate a
molte stampanti con l'opzione -P dei comandi. [Il programma lpr é come un
comando.|

Di solito si usa chiamare la vostra stampante principale PostScript@®) come
“ps” e chiamare la vostra stampante di testo “1p”.

7.2.3 1l Dispositivo di Stampa

La prossima parte del nostro esempio di entrate printcap identifica il dispositivo
di stampa. in tutti gli esempi citati ¢’é¢ una linea:

:1p=/dev/1p1:\
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w

[Ancora, notate che “\” alla fine della linea, cosi some 'inizio con “:“ con relativi
spazi di rientro.]

Il tag “1p=" porta il nome del dispositivo di stampa. In questo caso &
/dev/1pl, ovvero la porta parallela. Ci sono stampanti che che si connetto-
no tramite porta seriale. se ne avete una, dovrete usare /dev/ttySO per la
prima porta seriale, /dev/ttyS1 per la successiva e cosi via. Se volete aggiun-
gere altri comandi relativi alla stampante nelle entrate di printcap, come il
baud rate della stampante, dovete riferirvi alle man pages di printcap, che
possono aiutarvi.

Molte stampanti, tuttavia, usano la porta parallela. In aggiunta, la por-
ta stampante sulla maggior parte dei computer PC-compatibli sard /dev/1p1.
Se volete sapere perché, guardatevi questa nota.? Il vostro sistema non sa-
ra differente, tuttavia controllate sempre a cosa corrisponde la vostra porta
parallela.

7.2.4 La Directory Spool e il File Log

Oltre a dare un nome alla vostra stampante e a dire a Linux quale dispositivo
é, avete ancora bisogno di una directory per il print spooling. la sigla “sd="
identifica la directory di spool per la stampante. E’ inoltre una buona idea
avere un log file per gli eventuali errori. la sigla “1f=" lo identifica.

Molti sistemi mettono tutte le code di stampa nella directory /var/spool/1lpd;
alcuni usano solo /var/spool. In ogni caso, entrata del printcap tradizional-
mente ha la sua propria spool directory dichiarata dopo il nome della stampante.
Dovrete essere “root” e creare queste directory da soli. Dovrete inoltre cambiare
la proprietd di queste directory, cosicché il loro gruppo sia il gruppo daemon.
Potete farlo col comando, “chgrp daemon dirname”, dove dirname é il nome
della directory di spool.

Ad esempio, guardiamo I’entrata per la stampante “ps” nell’esempio. Con-
tiene le linee:

:sd=/var/spool/lpd/ps:\
:1f=/var/spool/lpd/ps/errs:\

Questo indica che la directory di spool é /var/spool/lpd/ps e che il log file &
/var/spool/lpd/ps/errs. Dovete “creare” questo file con il comando “touch
errs” nella directory di spool.

Similmente, ’entrata per la stampante “1p” contiene:

2Perché & /dev/1pl e non /dev/1p0 la prima porta stampantet? Va rilevato che 'indirizzo
1/O di ogni porta parallela & codificato nel kernel di linux. L’indirizzo 0x3BC & /dev/1p0;
I’indirizzo 0x378 & /dev/1pl; e 0x278 & /dev/1p2. Dato che molti dei computer PC-compatibli
assegna la prima porta parallela all’indirizzo 1/O 0x378 di default, /dev/1pl sara quindi la
porta parallela sulla maggior parte dei sistemi.

Se avete piu di una porta parallela, la situazione cambia. Inoltre se alterate 'indirizzo I/O
della porta per qualsiasi motivo, poi uno degli altri dispositivi 1p potrebbe puntare sulla porta
parallela. Su alcuni sistemi questo puo creare molti problemi. in alcuni casi potete andare in
DOS é controllare quale indirizzo é stato assegnato alla vostra porta. Dopodiché potete usare
questo indirizzo per stabilire se la porta parallela é /dev/1p0, /dev/1pl, o /dev/1p2.
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:sd=/var/spool/1lpd/1lp:\
:1f=/var/spool/lpd/1p/errs:\

Ancora, la spool directory é /var/spool/1pd/1p eil log file ¢/var/spool/lpd/1lp/errs.

7.2.5 1l Filter File

A differenza di “1p”, che passa semplicemente il testo non formattato alla stam-
pante, le stampanti “draft” e “ps” hanno bisogno di un filtro [ecco perché c’e
una riga addizionale]. La riga printcap per il programma filtro é “if=" [sta per
input filter, significa 'input dello spool].

Ci sono generalmente molte righe per i programmi filtro, che permettono di
specificare un filtro differente per diversi scopi. Potete selezionare i filtri come
opzioni a lpr, ma non ci inoltriamo per questa strada.

Diamo un’occhiata alle righe per la stampante “ps”:

:if=/var/spool/lpd/ps/ps.filter:\

Il file “ps.filter” & uno script di shell che risiede nella directory di spool
per la stampante “ps”. Potete anche specificare 'indirizzo e il nome del file
del programma; tuttavia, chiamando un programma con uno script di shell vi
permette di specificare le opzioni dalla riga di comando.

Tutti i filtri, sia programmi o script di shell, dovrebbero prendere I'input da
stdin [il flusso di input standard] e mandare il loro output a stdout [il flusso
standard di uotput.the standard output stream)].

7.2.6 Entrate Addizionali

Ci sono tre cose addizionali che dovete mettere nel vostro printcap. Potete
vederle alla fine dei tre esempi, e sono:

:mx#0:\

:sh:\

:sf:
11 “mx#0” significa “non limitare la grandezza del file che possiamo stampare.” 11
“sf” previene che il form-feed sia mandato dopo la fine del documento. Infine, I

“sh” previene che 'intestazione sia mandata all’inizio di ogni job. Probabilmente
voi volete sempre aggiungere queste entrate al vostro printcap.

7.3 Creare un Filtro di Stampa

7.3.1 Stampare Files PostScript@®) Usando Ghostscript

Il modo piu semplice per far capire alla vostra stampante il PostScript@®) é
quello di usare il programma Ghostscript come filtro di stampa. Ci sono pro-
babilmente altri modi, ma questo & quello pit comune. Se, per qualche ragione
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non potete o volete usare Ghostscript, dovrete provvedere da soli [guardatevi
Printing-HOWTO per iniziare].

La prima cosa che dovete fare é installare Ghostscript. C’¢ almeno una
versione in ogni distribuzione Linux. se non c’¢é la potete ottenereThe first thing
you should do is install Ghostscript. There should be a version in your Linux
da uno dall’archivio FTP di Linux sunsite.unc.edu. Una volta installato,
lanciatelo usando

gs -h | more

dalla linea di comando. Questo fara una lista dei dispositivi di stampa disponibili
con relativi formati. Qui di seguito riportiamo una lista che vi aiuta a capire
meglio a quale dispositivo Ghostscript corrisponde ogni stampante.

e Stampanti Apple:

appledmp Apple dot matrix printers
iwhi Imagewriter in high-res mode
iwlo Imagewriter in low-res mode

iwlq Imagewriter LQ in 320 x 216 dpi mode
e Stampanti Canon:

bj10e BubbleJet BJ-10e

bj200 BubbleJet BJ-200

bjc600 Color BubbleJet BJC-600, BJC-4000 and BJC-70.3
bjc800 Color BubbleJet BJC-800

Ibp8 LBP-II8 laser printer

lips3 LIPS-III laser printer in CaPSL mode

e Stampanti DEC:

la50 LA50

la70 LA70

la70t LA70 with low-res text enhancement
la75 LA75

la75plus LA75 Plus

In03 LNO3

1j250 LJ250 color printer

declj250 Alternate LJ250 driverQ

3Buona anche per alcune Apple come la StyleWriter 2x00
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e Stampanti Epson:

ap3250 ActionPrinter AP3250 [ed ogni stampante che usa il linguaggio
ESC/P2]

escp2 Tutte le stampantil Epson che usano i comandi ESC/P2 [questo
driver non é piu disponibile, usare ap3250.]

epson All 9- and 24-pin dot matrix printers [e compatibili

eps9mid All 9-pin dot matrix printers [e compatibili] in intermediate
resolution

eps9hi All 9-pin dot matrix printers [e compatibili] in triple resolution

epsonc LQ-2550 color printer [buono anche per Fujitsu 1200, 2400, e3400]

st800 Stylus 800 inkjet

stcolor the Stylus Color, Stylus Color Pro, Stylus Color II and IIs color
inkjet printers

e Stampanti Hewlet Packard [HP]:

Ip2563 2563B line printer
cdeskjet DeskJet 500C with 1 bpp color

cdjcolor DesklJet 500C [and 540C] with 24 bpp color and Floyd-Steinberg
dithering

cdjmono DeskJet 500C [and 510C, 520C, 540C], monochrome only.
cdj500 same as cdjcolor

cdj550 DeskJet 550C and 560C

deskjet DeskJet and DeskJet Plus

djet500 DeskJet 500

djet500c Alternate DeskJet 500C driver [does not work with the 550C
or the 560C]

dnj650c DesignJet 650C

ljet2p LaserJet I1d, LaserJet IIp, and LaserJet IIT* with TIFF compres-
sion

ljet3 LaserJet IIT* with Delta Row compression

Ljet3d LaserJet ITIID with duplex capability

ljet4 LaserJet 4 [default res=600dpi]

lj4dith LaserJet 4 with Floyd-Steinberg dithering

Ljetplus LaserJet Plus

pj PaintJet XL

pjetxl Alternate PaintJet XL driver

pjxl PaintJet XL color
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pjx1300 PaintJet XL300 color [and 1200C]

paintjet Alternate PaintJet color driver
e Stampanti Tektronix:

t4693d2 4693d color printer with 2 bits/RGB component [=6 bpp]
t4693d4 4693d color printer with 4 bits/RGB component [=12 bpp]
t4693d8 4693d color printer with 8 bits/RGB component [=24 bpp]
tek4696 4695 and 4696 inkjet plotters

e Stampanti varie:

cp50 Mitsubishi CP50 color printer

ibmpro IBM 9-pin Proprinter

imagen Imagen ImPress printers

jetp3852 IBM Jetprinter ink-jet color printer (Model #3852)
m8510 C.Itoh M8510 printer

necp6 NEC P6/P6-+ /P60 printers at 360 dpi

nwp533 Sony Microsystems NWP533 laser printer [Sony only]
0ce9050 OCE 9050 printer

okil82 QOkidata MicroLine 182

okiibm Okidata MicroLine IBM-compatible printers

r4081 Ricoh 4081 laser printer

sj48 StarJet 48 inkjet printer

sparc SPARCprinter

xes Xerox XES printers (2700, 3700, 4045, etc.)

Se il pacchetto Ghostscript che avete nella vostra distribuzione non include la
vostra stampante potete sempre scaricarvi il codice e compilarvelo da soli. Se
la vostra stampante non é direttamente supportata da Ghostscript, provate a
scegliere una compatibile.

Notate che alcune stampanti richiedono comandi speciali. Ad esempio il
driver stcolor richiede che il file stcolor.ps sia letto prima dell’input file. Vi
conviene leggere la documentazione di Ghostscript per i dettagli.

Poi, create il filtro. Suggeriamo di dargli il nome “pname.filter”, do-
ve“pname” é il nome che avete dato alla stampante nel file printcap. Suggeria-
mo inoltre di mettere lo script di filtro nella directory di spool della stampante.
1l filtro dovrebbe contenere quanto segue:

#!/bin/sh
/usr/bin/gs -q -dSAFER -dNOPAUSE -sDEVICE=devname \
[-rResNum FExtraOptions] -sQutputFile=- [precmd.ps] -
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dove devname é il nome del dispositivo Ghostscript; ResNum € la risoluzione che
volete usare;s the resolution you want to use; ExtraOptions indica ogni opzione
addizionale passata a Ghostscript; e “precmd.ps” € il nome del file che deve
essere letto prima dell’input [come il file stcolor.ps per il driver stcolor]. La
“\” spezza il comando in linee multiple.

Notate che gli esempi fatti assumono che gs sia nella directory /usr/bin. Il
vostro sistema potrebbe avere una configurazione diversa.

Differenti drivers Ghostscript trattano I’argomento “-r” differentemente. Al-
cuni cercano un numero singolo, ad esempio, “-r600”. Altri vogliono risoluzioni
DPI separate per le direzioni x e y, es. “-r360x360”. Il driver della stam-
pante puo avere altre opzioni, quindi ¢ meglio consultare la documentazione di
Ghostscript per maggiori informazioni.

Dopo che avete creato il printer filter, usate “chmod a+x” sullo script file per
renderlo eseguibile. [dovete essere root per farlo].

Ecco un esempio print file Ghostscript, usato da JOHN WEISS per la sua
Epson Stylus Color IIs:

#!/bin/sh

/usr/bin/gs -q -dSAFER -sDEVICE=stcolor \
-r360x360 -sDithering=fsmono \

-dNOPAUSE -dnoWeave \

-sOutputFile=- stcolor.ps -

Questo filtro genera un output monocromatico a 360dpi su una Epson Stylus
Color IIs.

7.3.2 Se Gia avete una Stampante PostScript®). . .

Molte stampanti laser moderne oggi hanno il supporto per PostScript@®). Su
alcune stampanti laser, PostScript@®) ¢ attualmente il linguaggio nativo della
stampante. Se avete una stampante, non avete bisogno del filtro e potete passare
un file PostScript@®) direttamente alla stampante. Di contro, se volete stampare
un file di testo, avrete comunque bisogno di formattarlo in qualche modo in
PostScript®).

Siamo a conoscenza di tre programmi che traducono il testo ASCII in PostScript®):
nenscript, a2ps, e mpage. mpage possono anche stampare pagine multiple su
un singolo foglio di carta. Dovete quindi creare uno script di filtro usando
uno di questi programmi per la stampante 1lp. [La stampante lp & tradizio-
nalmente il nome della stampante che stampa file di testo ASCIL] Leggete il
Printing-HOWTO per maggiori informazioni.

4Nota da Joun WEiss: Questa é la mia stampante ps. Lo uso un filtro simile sulla stampan-
te draft, che ha I'opzione -r180x180 invece di quello che avete visto. E per la mia stampante
color, uso un valore differente dell’opzione -sDithering.
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7.4 Il Demone Print Spool, 1pd

Il programma che generalmente fa lo spooling e la stampa dei files & 1pd. E’
anche il programma che legge il file /etc/printcap. Da qualche parte nei vostri
scripts di bootup,® dovete eseguire 1pd per iniziare lo spooling ad ogni avvio
del sistema. Potete anche eseguire 1pd come un job di backgroung dalla linea
di comando se loggate come root.

Una volta che 1pd é in esecuzione sul vostro sistema, potete controllare il
suo comportamento e quello del print spool usando il comando 1pc. Ancora
una volta, dovete essere root per pare cio.

7.5 Assemblando il Tutto

Concluderemo questo mini-HOWTO con i passaggi che dovete seguire per ave-
re un setup minimale. Quando avrete finito, avrete due stampanti, una chia-
mata “1p” per stampare testoASCII, e una seconda chiamata “ps” per i files
PostScript@®). 1 file filtro per la stampante “ps” [incluso sotto| funziona su
ogni stampante compatibile Epson [ovvero pressocché la totalita delle stampan-
ti dot-matrix attualmente in commercio], usando la risoluzione di stampa di
default.

1. Entrate come “root” o usate “su root”.

2. Eseguite i seguenti comandi:

(a) cd /var/spool
ir
b) mkdir 1lpd
se non esiste gia
iste gia
(c) chgrp 1lp 1lpd
[potreste dover usare “daemon” al posto di “1p’]
(d) cd 1pd
(e) mkdir 1lp ps
[fatelo solo se queste directory non esistono gia]
touc errs ps/errs
f h 1p/ ps/
(g) chgrp daemon lp ps lp/errs ps/errs

3. Ora editate il file /etc/printcap

(a) Se il file esiste, quindi. ..

i. ...rinominate la vecchia versione in qualcosa tipo “/etc/printcap.orig’
ii. ...oppure, commentate tutto il file mettendo “#” all’inizio di ogni
riga.

5Alcune macchine tengono i loro scripts di bootup nella directory /etc/rc.d. Altri usano
/etc/init.d. Dovete capire da voi che sistema é usato.
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(b) Mettete quanto segue in /etc/printcap:

lplText printer:\
:1p=/dev/1p1:\
:sd=/var/spool/1lpd/1p:\
:1f=/var/spool/lpd/1p/errs:\
:mx#0:sh:sf:
ps|Postscript printer:\
:1p=/dev/1pl:\
:sd=/var/spool/lpd/ps:\
:1f=/var/spool/lpd/ps/errs:\
:if=/var/spool/lpd/ps/ps.filter:\
:mx#0:sh:sf:

(¢c) ASSICURATEVI CHE:

i. le linee bianche tra due entrate non abbiano nulla al loro interno,
nemmeno spazi bianchi.

ii. niente segue il carattere “\” alla fine di ogni linea.
4. Poi, create lo script filtro per la stampante “ps”.

(a) Mettete quanto segue nel file /var/spool/lpd/ps/ps.filter:
#!/bin/sh
/usr/bin/gs -q -dSAFER -dNOPAUSE \
-sDEVICE=epson -sOutputFile=- -
[Se non avete una stampantedot-matrix compatibile Epson, rimpiaz-
zate “epson” con l’appropriato nome del dispositivo Ghostscript.
Inoltre, se il programma gs non é in /usr/bin, mettete 'indirizzo
corretto.]
(b) Eseguite questi comandi:

i. chmod at+x /var/spool/lpd/ps/ps.filter
ii. chgrp daemon /var/spool/lpd/ps/ps.filter

5. Infine, lanciate il demone della stampante, 1pd:

(a) Se non ¢ gid in uso, usate “1pd &’ per avviarlo.

b) Se é gia in esecuzione, eseguite “1pc”. Poi, da dentro 1pc, date un
g g p P
“restart all” e un “up all” per attivare i nuovi spools di stampa.
[Il comando “quit” abbandona lpc].

(c) Assicuratevi di aggiungere il comando appropriato ai vostri scripts
di bootup in modo che 1pd sia eseguito ad ogni avvio del sistema.

6. Potete ora uscire da root e testare le vostre nuove stampanti per assicu-
rarvi che funzionino. Date il comando “lpr -Plp” seguito dal nome di un
piccolo file di testo ASClIIper verificare che la stampante “1p” funzioni.
Poi usate “1pr -Pps” seguito dal nome di un piccolo file PostScript@®) per
testare la stampante “ps”.
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Un avvertimento: quando testate “ps”, se qualcosa va storto, il sistema potrebbe
passare dell’iimondizia alla stampante. Se avviene questo, spegnete la stampante
ed usate i comandi 1pq e 1prm per killare il print job. Dopo aver killato il print
job, potete riaccendere la stampante.

Se nessuna di queste stampanti funziona, controllate di nuovo tutto, con-
sultate le pagine man per printcap e 1lpd, e leggete il Printing-HOWTO per
aiuto.

Se tutto funziona, congratulazioni!



Capitolo 8

II materiale esterno

8.1 Background

Una caratteristica spesso richiesta dagli utenti LyX é quella di interfacciare LyX
con Xfig, Dia, o altre applicazioni specializzate nella produzioni di un certo tipo
di diagrammi, figure, schemi e simili cose che possono essere rilevanti per il
vostro documento. Prima in Iy’X era solo possibile includere immagini fisse,
statiche, noiose con l'insieme figure, ma ci sono numerose limitazioni relative a
questo approccio:

o Se volete cambiare la figura, dovete richiamare manualmente un program-
ma esterno

e LiyX non notifica i cambiamenti ai riferimenti dei files, cosi quello che &
visualizzato sullo schermo puo rapidamente diventare obsoleto, e questo &
aggravato da una media di aggiornamenti dello schermo

e L’insieme delle figure supporta solo materiale PostScript

e L’insieme delle figure non fornisce nessun meccanismo per copiare con
differenti formati esportati come DocBook, HTML, o raw Ascii

L’insieme del materiale esterno prova a risolvere tutti questi problemi'. FEf-
fettua cio offrendo un metodo generale per interfacciare LyX alle applicazioni
esterne. Invece di introdurre una lunga lista di insiemi ritagliati per ogni spe-
cifica applicazione, abbiamo scelto di sacrificare la visualizzazione in line del
materiale incluso al fine di fornire uno strumento generale per affrontare una
grande quantitd di applicazioni. Il risultato & l’insieme esterno. Un insieme
esterno presenta se stesso nel documento semplicemente come un bottone, ma
non lasciatevi ingannare. Quando ci cliccate sopra, apparird una finestra di

I Anche se I’insieme delle figure non pud risolvere tutti i problemi, & ancora valutabile perché
fornisce un’anteprima in linea della figura, e supporta trasformazioni geometriche avanzate con
una semplice interfaccia utente.

65
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dialogo che vi permettera di scegliere esattamente quale materiale includere, é
piu avanti imparerete che in realtd ¢ un potente meccanismo che puo risolvere
molti problemi ed anche di pii.

8.2 Come funziona?

L’insieme esterno € basato sul concetto di template. Un template & una spe-
cificazione di come LyX dovrebbe interfacciarsi con un certo tipo di materiale.
In genere Iy X viene distribuito con una serie di template predefiniti per figu-
re XFig, diagrammi Dia, varie immagini in formato raster, gnuplot, ed oltre.
Potete controllare la lista attuale attraverso il comando Inserti>Insert external
material. Inoltre, é possibile adattare i vostri personali template per supportare
uno specifico tipo di materiale. Piu avanti descriveremo piu in dettaglio gli ele-
menti coinvolti, e si spera che possiate creare dei template che poi ci manderete
per includerli nelle successive versioni di LyX.

Un’altra idea di base dell’insieme esterno é di distinguere tra il file originale
che serve come base per il materiale finale e il file prodotto che & incluso nel
vostro documento esportato o stampato. Per esempio, consideriamo il caso di
una figura prodotta con XFig. L’applicazione XFig lavora su un file originale
con estensione .fig. All'interno di XFig create e modificate la vostra figura, e
quando avete finito salvate il file fig. Quando vorrete includere la figura nel
vostro documento, basta richiamare transfig al fine di creare un file PostScript
che puo essere prontamente incluso nel vostro file WTEX. In questo caso, il file
.fig é il file originale, ¢ il file PostScript é quello prodotto.

Questa distinzione ¢ importante al fine di effettuare ’aggiornamento del ma-
teriale mentre si € in fase di scrittura del documento. Inoltre, ci fornisce quella
flessibilita che é necessaria per supportare molteplici formati di export. Ad
esempio, nel caso di un file Ascii, non ¢é esattamente una buona idea quella di
includere la figura come un raw PostScript; dovreste invece preferire ’include-
re un riferimento alla figura oppure provare a richiamare qualche convertitore
grafico da Ascii per rendere il risultato finale accettabile. L’insieme materiale
esterno vi permette di farlo, perche é parametrizzato su differenti formati di
export supportati da LyX.

Oltre a supportare la produzione di differenti prodotti in relazione al formato
esportato, 'insieme esterno supporta una stretta integrazione con le applicazio-
ni di editing e di visualizzazione. Nel caso di una figura XFig, potete richiamare
xfig sul file originale con un singolo clic all’interno di LyX oltre che avere un’an-
teprima del file PostScript prodotto con ghostview sempre con un semplice clic.
Non c’é pit bisogno di smanettare con la riga di comando o con il browser per
trovare e manipolare i files originali o quelli prodotti. In questo modo potrete
finalmente utilizzare a pieno molte differenti applicazioni che risultano rilevanti
nella scrittura di un documento, al fine di essere maggiormente produttivi.

Quindi, in definitiva, LyX ha informazioni circa un numero di programmi
differenti da usare dietro le quinte per realizzare tutto questo marchingegno.
Questa informazione, infatti, & esattamente cid che é contenuto nei templates.
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Per ogni template, c’é associata una lista di linee di comando usate per irchia-
mare le applicazioni, convertire il file originale nel file prodotto ed altro ancora.
Questo meccanismo permette all'utente avanzato di estendere le capacita di LyX
senza smanettare col codice sorgente. Questo richiede un imponente lavoro per
definire tutti i differenti comandi e flags, ma fortunatamente, il team di LyX ha
gia fatto questo lavoro per voi!

Ma prima che gli alberi diventino grattacieli, dobbiamo ammettere che ab-
biamo fatto alcuni piccole scorciatoie. Siccome il set esterno pud produrre molti
tipi di files prodotti per i relativi formati di export, ci si potrebbe anche aspetta-
re che sia possibile vedere ’anteprima di ogni prodotto. Ma, ancora una voltea,
il team di LyX ha deciso per una linea che mantenesse l'interfaccia utente sem-
plice. Per evitare di mettere un pulsante per ogni formato di file esportato, si
é deciso di introdurre il concetto di formato primario di file ed avere solo un
bottone. Quando si preme View result nella finestra dell’insieme esterno, verra
visualizzata un’immagine del file prodotto nel formato di file primario. E questo
é specificato dalla vostra classe di documento. Per la maggior parte delle classi
di documento il formato primario di file &€ BTEX, ma per la classe di documento
DocBook, il formato di file primario ¢ DocBook. Cosi quando si visualizza il file
prodotto, ricordatevi che sara solo un’anteprima di quello che sara il risultato
principale. Se volete vedere come lavorano gli altri formati, dovete esportarli e
fare ’anteprima manualmente.

8.3 La finestra di dialogo Materiale Esterno

Inserite un insieme esterno dal menu Insert. Quando fate questo, un bottone
viene inserito nel vostro documento e viene mostrata la finestra di dialogo dell’in-
sieme materiale esterno. Questa finestra vi permette di descrivere esattamente
quale materiale deve essere incluso. Inoltre, fornisce un accesso alle applicazioni
esterne per vedere, editare e produrre il materiale usato nel file risultante.

In cima a questa finestra, c’é una lista a cascata dove & possibile scegliere
quale template l'insieme deve usare. Immediatamente sotto troviamo un’area
di testo con una descrizione del template scelto che dovrebbe aiutarvi ad usarlo.
Piu spesso, fornisce oltre ad una descrizione del template anche alcune indica-
zioni su come parametrizzarne 1’'uso. Ancora piu in basso si trova un campo
di inserimento di nome di file con un bottone browse che permette di scegliere
quale file deve essere incluso. Questo campo specifica il file originale. Siccome
il file prodotto é generato automaticamente quando se ne ha bisogno, non c’é
motivo per consentirne ’accesso nell’interfaccia utente.

In basso alla finestra di dialogo troverete una casella di immissione chiamata
parameters. Questo box & generalmente usato per parametrizzare uno specifico
template. L’uso specifico dovrebbe essere indicato e chiarito nella casella di
definizione e aiuto associata al template, ma in genere permette tipicamente di
definire le variazioni su come il file prodotto dovrebbe essere generato.

Nella parte destra della finestra ci sono tre bottoni: Edit file, View result e
Update result. Questi rispettivamente permettono di editare il vostro file origi-
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nale con 'applicazione di editing opportuna, vedere il file prodotto come incluso
nel formato primario di documento, ed infine forzare un aggiornamento del ma-
teriale risultante nel formato primario. Normalmente il bottone Update result
sard disabilitato perché molti template sono configurati per aggiornare auto-
maticamente il file prodotto quando ce ne é bisogno. In questi casi non c’é
bisogno di forzare la produzione di un nuovo file prodotto. Tuttavia alcuni tem-
plates sono configurati per non produrre automaticamente il prodotto residuale,
in quanto il costo di produrre un file prodotto potrebbe essere cosi grande da
renderne impossibile 'attuazione. Questi insiemi sono conosciuti come insiemi
manuali esterni. In questi casi potete usare il bottone per forzare la produzione
del file prodotto proprio quando ne avete bisogno, controllando cosi il lavoro
che viene fatto. Infatti, & sotto la vostra responsabilita fare questo per man-
tenere i files prodotti costantemente aggiornati: prima di stampare, prima di
esportare, prima di visualizzare, ecc. Forse, in futuro, sara possibile che LyX
vi aiuti in questo compito. Sarebbe infatti simpatico poter usare un comando
Edit > Update all external inset per aggiornare tutti gli insiemi esterni che usano
un template manuale. Ma vi anticipiamo che potrebbe richiedere molto tempo
per I'implementazione.

In basso alla finestra di dialogo troverete i soliti bottoni OK e Cancel. L’unica
cosa utile da ricordare circa questi é che ogni cambiamento nel template, nome
del file o parametri sono attualmente applicati quando si premono i bottoni Edit
file, View result e Update result. Questo implica che dopo aver usato uno di
questi, potrete sono annullare i cambiamenti che sono stati effettuati attraverso
quei bottoni premendo cancel. Fortunatamente, potete usare la funzione undo
generale in Iy X per ritornare allo stato precedente.

8.4 Esempi

In questa sezione, dovremmo includere alcuni esempi circa 'uso dell’insieme del
materiale esterno. Questi esempi potrebbero includere:

¢ Immagini raster esterne
o figure esterne XFig

e Diagrammi a scacchi

Campioni di suoni

Uso dei makefiles

Templates LyX esterni ricorsivi

8.5 Il file di configurazione external template

E’ relativamente semplice aggiungere definizioni di template esterni a Iy’X. Tut-
tavia state attenti poiché fare queste cose in maniera approssimativa potrebbe
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probabilmente creare un buco di sicurezza facilmente sfruttabile. Cosi prima di
procedere, leggete il successivo capitolo sulla sicurezza.

Dopo aver detto queste cose, vi incoraggiamo a farci pervenire ogni template
interessante che create.

I templates sono definiti nel file 1ib/external _template. Forse, prima o poi
qualcuno documentera i contenuti dei templates e la sintassi usata per definirne
di propri.

8.6 Il meccanismo di sostituzione

Quando l’insieme del materiale esterno richiama un programma esterno, é fat-
to sulla base di un comando definito nel file di configurazione del templa-
te. Questi comandi possono contenere varie macro che vengono espanse pri-
ma dell’esecuzione. L’esecuzione avviene sempre nella directory del documento
contenuto.

Inoltre, ogni volta che viene visualizzato un insieme esterno, il nome sara
prodotto dal meccanismo di sostituzione.

Le macro disponibili sono le seguenti:

$$FName Il nome del file specificato nella finestra dell’insieme esterno.
$$Basename Il nome del file senza estensione.

$$Tempname Un nome e un indirizzo completo di un file temporaneo che
sard automaticamente cancellato quando si chiude il documento contenuto,
oppure quando é cancellato I'insieme esterno.

$$Contents("filename.ext") Questa macro espandera il contenuto del file
col nome filename.ext.

$8Sysdir Questa macro espandera all’indirizzo assoluto della directory di si-
stema. E’ tipicamente usato per puntare i vari script di aiuto che sono
inseriti in IyX

In aggiunta a questi gli strumenti espanderanno le variabili d’ambiente generali
con una sintassi del tipo ${PATH}.

8.7 Discussione sulla sicurezza

L’insieme del materiale esterno si interfaccia con molti programmi esterni e lo fa
automaticamente, per questo vanno considerate le implicazioni di sicurezza di
questo. In particolare, siccome avete ’opzione di includere dei vostri nomi dei
file e/o stringhe di parametri, e questi vengono aperti in un comando, sembre-
rebbe che sia possibile creare un documento maligno che puo eseguire comandi
arbitrari quando un utente vede o stampa un documento. Questo lo vogliamo
definitivamente evitare.



70 CAPITOLO 8. IL MATERIALE ESTERNO

Tuttavia, dato che i comandi dei programmi esterni sono specificati solo nel
file di configurazione del template, non ci sono problemi di sicurezza se LyX €&
configurato bene solo con templates sicuri. E’ cosi perche i programmi esterni
sono richiamati con la chiamata di sitema execvp piuttosto che con system,
quindi non é possibile eseguire comandi arbitrari dal file o dalla sezione dei
parametri attraverso la shell.

Tutto cio implica che siete limitati nelle stringhe di comando che potete usare
nei template dei materiali esterni, In particolare canali e redirection non sono
subito disponibili. Cio dovrebbe essere cosi se LyX dovesse rimanere sicuro.
Se volete usare alcune funzioni della shell, dovrete scrivere uno script sicuro
per farlo in maniera controllata, dopodoché richimare lo script dalla linea di
comando. Nella directory 1ib/scripts dell’installazione di LyX, potrete trovare
uno script sicuro preconfezionato general_command_wrapper.py che supporta
la redirection di input e output. Questo puod essere un esempio di come scrivere
script di template sicuri. Per un esempio piu avanzato che usa fork e simili,
date uno sguardo allo script di conversione pic2ascii.py.

E’ possibile progettare un template che interagisce direttamente con la shell,
ma, dato che questo potrebbe permettere ad un utente con cattive intenzioni di
eseguire comandi arbitrari scivendo intelligenti filename e/o parametri, racco-
mandiamo in generale di usare solo script sicuri che lavorano solo con le chiamate
di sistema execvp in maniera controllata. Naturalmente se si lavora in un am-
biente controllato potrebbe essere allettante ritornare ad usare gli script di shell
ordinari. Se lo fate state attenti poiché andrete a creare un buco di sicurezza
facilmente sfruttabile nel vostro sistema. Naturalmente é ragionevole che questi
templates non sicuri non verranno mai inclusi nella distribuzione Iy’ X standard,
sebbene incoraggiamo le persone a sottoporre nuovi templates nella tradizione
open source. Ma LyX come rilasciato nei canali ufficiali di distribuzioni non
avra mai tamplates non sicuri.

L’insieme del materiale esterno fornisce molta potenza, percid dovete stare
attenti a non introdurre elementi di azzardo sulla sicurezza a questa potenza. Un
lieve errore in una singola riga di un semplice script puo creare grandi problemi
di sicurezza. Cosi, se non capite completamente questo tema, vi consigliamo di
consultare un professionista della sicurezza oppure il team di sviluppo di LyX se
avete domande sulle implicazioni di sicurezza circa uno script. E, ovviamente,
fate questo prima di usare lo script in un ambiente non sicuro.

8.8 Il futuro dell’insieme esterno

La corrente implementazione dell’insieme esterno éun costrutto potente e stabile
che fornisce un accesso diretto alle parti piu interne di LyX, ma come ogni
caratteristca di LyX, dovrebbe essere sempre considerata un work-in-progress.
Quando e se qualcuno ha il tempo di continuare a lavorarci su, ecco alcune
direzioni generali che possono essere seguite:

e Supportare I’anteprima in linea in vari formati, piuttosto che il bottone di
testo a cui si & obbligati attualmente.
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e Supportare 'editing in linea attraverso 'uso di OpenParts o altri protocolli
rilevanti.

e Estendere l'informazioni dinamica per avere campi di parametri opzionali
per i comandi di conversione in tutti i formati di export, ed avere campi di
parametri opzionali per cido che é prodotto all’interno di tutti i differenti
formati esportati. Al momento siamo costretti ad usare una sola stringa
di parametri che & multiplata tra queste numerosi applicazioni. Inoltre
un cambiamento come questo ci permetterebbe di liberarci delle strane
restrizioni del formato principale.

e Estendere 'area di lavoro per fornire delle opzioni di personalizzazione pit
intelligenti in aggiunta alla piuttosto semplicistica stringa di parametri.
Con un linguaggio di script adatto, sara possibile implementare versioni
user friendly di molti insiemi di personalizzazione che supportano una
grande quantita di formati, pacchetti IATEX, editors, ecc.



